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Introduction to Dragon Group
This guide is for administrators installing and configuring Dragon Group products, which include Dragon Professional 
Group and Dragon Legal Group. When we talk about these products in this guide, we’ll simply refer to them as “Dragon 
Group.”

Dragon Group is available in NMS in the Cloud or Stand-Alone mode. 

NMS in the Cloud includes a centralized server, hosted by Nuance, which you can access via the Web-based Nuance 
Management Console (NMC). Use this guide to install the Dragon Client on your end-user machines and configure them 
to connect to the server. See the Nuance Management Server Administrator Guide, available at http://www.nuance.
com/product-urls/default.asp?f=products-1.xml&p=dragonprogroup&v=1&c=support&l=0, to learn how to manage your 
users and settings in the NMC. 

Stand-Alone users must manage their Dragon Clients on the end-user machines. Once you have installed the Dragon 
Client on your end-user machines, skip to “Scheduling Optimization Tasks” on page 43. Additional information can be 
found in the Dragon Help, accessible through the Dragon Client interface or at http://www.nuance.com/products/
help/dragon/dragon-for-pc/enx/professionalgroup/main/Content/GetStart1.htm

Note: Some product features might have changed since this manual was printed. A current version of this 
book is always available on Nuance's iSupport portal, in PDF format. Contact your Nuance representative 
about accessing that portal to retrieve the latest copy.

http://www.nuance.com/product-urls/default.asp?f=products-1.xml&p=dragonprogroup&v=1&c=support&l=0
http://www.nuance.com/products/help/dragon/dragon-for-pc/enx/professionalgroup/main/Content/GetStart1.htm
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Overview of Nuance Management Server in the Cloud
Dragon Group with Nuance Management Server (NMS) in the Cloud introduces a client-server architecture to Dragon 
Group.

NMS in the Cloud allows you to administer all of your Dragon Clients at once from a centralized server hosted by 
Nuance. You can access the server via the Web-based Nuance Management Console (NMC).

NMS in the Cloud stores your installation’s data objects in a cloud-based server that is hosted by Nuance. Stored data 
includes:

 l User accounts

 l User licenses

 l Text and Graphics/Auto-texts

 l Custom words

 l Custom Command Sets

If your organization uses multiple Nuance products, NMS in the Cloud allows you to share data across multiple 
Nuance applications. For example, if an administrator at an organization creates an Auto-text in the Management 
Console, that organization’s users can see and use that object with Dragon Group, as well as any application that 
uses Dragon Anywhere.

What will be different when you use NMS in the Cloud?
You can take cross-network action on Dragon Clients from the NMC:

 l Create user accounts for end-users.

 l Grant, revoke, and manage all dictating users and administrator licenses, including how many licenses of each 
type are available and how many are in use.

 l Divide users into multiple Sites and assign a backup location, Roaming user profile storage location, and allotted 
archive storage/playback space to all users on one Site.

 l Assign users to Groups and assign entire Groups to one or more Sites.

 l Manage Text and Graphics/Auto-texts and words. This can be done at the Site, Group or user level. 

 l Search for Groups or users associated with a particular Site.

 l Audit session events, such as which users have logged on, across the entire network for a specific time period or 
user.

 l Display a complete list of all downloaded updates and approve or deny their installation—all from a single window.

 l Choose to upload speech data to Nuance’s Research department for particular users or all users in your 
organization.
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Overview of Configuring NMS in the Cloud
This section provides an overview of how to configure Dragon Group with NMS in the Cloud. 

Before you begin
Before you begin, Nuance will send you a welcome email containing the information that you need to install and 
configure NMS in the Cloud, including:

 l The URL for NMS in the Cloud

 l Your Organization ID

 l Your administrator username and password

 l Your license key

Keep this information on hand as you install and configure Dragon Group.

Set up Master Roaming user profile storage (optional)
Set up the machine that will store your Roaming user profiles. For more on setting up Master Roaming user profiles, 
see “Roaming feature setup checklist” on the Dragon Help site.

Install the Local Authenticator (optional)
If you want to use Active Directory Single Sign-On for your authentication, you must install the NMS Local 
Authenticator. See “Installing the Local Authenticator” on page 19 for details.

If you want to use Dragon’s native authentication, you do not need to install the Local Authenticator.

Install and configure Dragon Group Clients
To install Dragon Group on end-users’ machines, see “Initial Installation of the Dragon Client” on page 26.

3
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Logging in to the Nuance Management Console
The Nuance Management Console (NMC) is a Web browser-based application that is part of the overall Nuance 
Management Server (NMS) system. The NMC supports many functions for Dragon Group, including reporting. You 
will need to be able to log in to configure Sites, Groups, and user accounts, (see the Nuance Management Server 
Administrator Guide) and to set up Active Directory services (see “Setting up the Nuance Management Server to Run 
Active Directory Services” on page 14). 

Log in to the Management Console
 1. Go to any workstation and open a browser window.

 2. In the Address bar, enter the URL of NMS in the Cloud. You should have received this URL in your welcome 
email. Then hit the Enter key. 

 3. When the Nuance Management Console login screen appears, enter the administrator user and password that 
you received in your welcome email, then click Log on.

 4. The End-User License Agreement will be displayed. Click Accept to enter the NMC.

 5. The homepage appears, showing links to the various features of the NMC:

4
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Migrating Users to NMS in the Cloud
You can add user accounts to NMS in the Cloud individually, or use a comma-delimited text file to import them in bulk. 
See “Import multiple users into the NMS server” in the Nuance Management Server Administrator Guide for details.

Organizations using NMS native credentials
If you are using NMS native logins to authenticate users, each user login must be unique. Any conflicts with existing 
user logins need to be resolved before users can be migrated to NMS in the Cloud. For example, if you are upgrading 
“Bob” to the Cloud, and user login “Bob” already exists in the NMS in the Cloud, this is a naming conflict. You must 
change the user login before you can move that user account to the Cloud. The Local Authenticator is not required.

Organizations using Active Directory

If you use Active Directory to authenticate users, there should be no conflicts when moving to the Cloud. NMS in the 
Cloud uses a “domain” along with the login, which maps to a unique organization.

For a new user, NMS generates a folder name using the format login_GUID and returns this to Dragon. Dragon uses 
this value to create the profile folder for the new user. NMS only appends the GUID to the profile folder name, not to the 
user profile.

For example, for a new user profile “bob,” NMS generates the folder name: bob_35B5CB9B-922B-47FB-AA20-
AE2E515D9802.

When the user logs into Dragon, NMS authenticates the user’s credentials and returns a unique name for Dragon to 
use to create the user’s profile location.
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System Requirements for Dragon Group
Dragon Client hardware recommendations
The Dragon Client installer checks your system for minimum requirements. If the minimum requirements are not met, 
the Dragon Client will not be installed.

Supported Operating Systems

 l Microsoft Windows 10, 32-bit and 64-bit

 l Microsoft Windows 8.1, 32-bit and 64-bit

 l Microsoft Windows 8 (including Professional and Enterprise), 32-bit and 64-bit

 l Microsoft Windows 7, 32-bit and 64-bit

 l Microsoft Windows Server 2008 R2

 l Microsoft Windows Server 2012 (64-bit only)

RAM

Minimum 2 GB for the 32-bit versions of Microsoft Windows 7, Windows 8, Windows 8.1, and Windows 10

Minimum 4 GB for all other supported operating systems

CPU

Minimum 2.2 GHz Intel® dual core or equivalent AMD processor

Note: Faster processors yield faster performance.

Free hard disk space

4 GB (8 GB recommended)

Audio devices

 l A sound card supporting 16-bit recording

 l A Nuance-approved microphone: headset microphone (USB or not), Bluetooth microphone (Enhanced/wideband 
works best), or user-facing built-in laptop microphone (single or multiple element) (See http://support.nuance.com/
compatibility/)

 l If you wish to make recordings for Dragon to transcribe: a voice recorder or smartphone app supporting one of 
these formats: .mp3, .m4a, .wav, .wma, .dss or .ds2

Other requirements

 l Internet Explorer 9 or higher, or the current version of Chrome or Firefox, for online Help

 l A DVD-ROM drive for initial installation

 l An Internet connection to automatically activate the software (a quick anonymous process) and, if you purchased 
the Dragon web installer instead of a DVD, to install the software

Supported Virtual Desktop Infrastructure Applications 
 l XenDesktop 7.6

 l XenApp 7.6

7
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Supported Software
Once you have installed Dragon Group, you can use it to control the following applications using your voice:

 l WordPad

 l NotePad

 l Microsoft Word 2010 (32 & 64-bit), 2013 (32 & 64-bit), 2016 (32 & 64-bit)

 l Microsoft Outlook 2010, 2013, and 2016

 l Microsoft Excel 2010, 2013, and 2016

 l Internet Explorer 9, 10, 11 (11 supported when Enhanced Protective Mode is disabled)

 l Mozilla® Firefox® version 24 or later

 l Google Chrome

8



Dragon Installation Guide

Dragon File Structure
During installation, Dragon sets up the following default folders for application and data storage.

Note: Upgrading Dragon from an earlier version automatically relocates some directories and files.

Windows 7, Windows 8.x, and Windows 10
Dragon setup log (dgnsetup.log)

C:\ProgramData\Nuance\NaturallySpeaking14\logs

Dragon log

C:\ProgramData\Nuance\NaturallySpeaking14\logs\<Windows_User_Name>

User profiles

C:\ProgramData\Nuance\NaturallySpeaking14\Users

Upgrade log

C:\Users\<Windows_User_Name>\AppData\Roaming\Nuance\NaturallySpeaking14

Local Roaming user profiles

C:\ProgramData\Nuance\NaturallySpeaking14\RoamingUsers

Vocabularies and Acoustic Models

C:\ProgramData\Nuance\NaturallySpeaking14\Data

Custom words and commands

C:\ProgramData\Nuance\NaturallySpeaking14\custom\<language>\

Program files

For 32-bit systems For 64-bit systems

C:\Program Files\Nuance\Nat-
urallySpeaking14\Program

C:\Program Files (x86)\Nuance\Nat-
urallySpeaking14\Program

Help

For 32-bit systems For 64-bit systems

C:\Program Files\Nuance\Nat-
urallySpeaking14\Help

C:\Program Files (x86)\Nuance\Nat-
urallySpeaking14\Help

Interactive Tutorial

For 32-bit systems For 64-bit systems

C:\Program Files\Nuance\Nat-
urallySpeaking14\itutorial

C:\Program Files (x86)\Nuance\Nat-
urallySpeaking14\itutorial
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Accessing program files
The Dragon Client and many associated utilities can be accessed through the Start menu. Their location varies by 
operating system: 

 l Windows 7: Select Start > All Programs > Dragon.

 l Some utilities are located inside the Dragon Tools subfolder.

 l Windows 8.x: From the Start screen, click the down arrow to show all applications. Scroll to find Dragon.

 l Windows 10: Select Start > All apps > Dragon.

10
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Assigning Access to Clients and Roaming User Profile Locations
Caution:  

To ensure that your Dragon Group network components can communicate with each other and that the network can 
function properly, you must assign permissions to all appropriate directories and access rights to administrator and 
user accounts on servers and clients as indicated in the table below.

Locations each dictating end-user client needs to access

Location or Registry Key Permissions level or type of 
access rights Users affected

Roaming user profiles folder Full read/write/modify permissions Windows user accounts for all end-
users dictating on Dragon Clients

Locations on the workstation where the user dictates with Dragon Client

C:\ProgramData\Nuance folder 
and all sub-folders

Full read/write/modify permissions Windows user accounts for all end-
users dictating on Dragon Clients

C:\Users\<Windows User 
ID>\AppData\ folder and all sub-
folders

Full read/write/modify permissions

Locations in Registry of the workstation where the user dictates with Dragon Client

HKEY_LOCAL_
MACHINE\SOFTWARE\Nuance

Rights to update the registry to 
read/write to these keys

Windows accounts used on 
workstations running Dragon Client

HKEY_CURRENT_
USER\SOFTWARE\Nuance

Assigning permissions to NMS component files, clients, and Roaming user profiles

Caution:  

Clients: To ensure every dictating user has appropriate access to his or her user profile, you must give full 
read/write/modify permissions to all files and directories housing the Roaming user profiles, even through http or 
https connections. This level of permission/access ensures that when the user dictates, Dragon can interact with 
the Roaming user profiles effectively. 

Each Windows user account that logs in to the Dragon Client workstation should also have read/write/modify access 
to the Roaming user profiles, since the Dragon Client frequently modifies these profiles.

Roaming user profiles: Be sure that when you set up the Roaming user profiles directory, you locate it either on a 
Windows machine or on a device connected to a Windows machine with .NET Framework 4.0 installed on it.

In NMS 5.0, the NMS supports deployments on standard ports (443/80). The NMS examines the standard ports to see 
if they are available. If they are not, it defaults back to the normal custom ports (8051 and 8731). 

11
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Configuring Client Workstations
Turning off Windows Automatic Updates
After you set up each physical server or workstation you plan to use in the network, be sure to turn off Windows 
Automatic Updates. For each update Windows sends, install it first on a single test machine; update other machines 
only after you have determined that it will not disrupt the network. 

Once you have determined an update is not going to negatively affect the network, install the update during off-hours 
and, if required, reboot each machine during those hours to ensure that requests to reboot do not disrupt the servers or 
workstations during peak hours of dictation.

Anti-virus recommendations
Nuance recommends anti-virus software on all Dragon Group servers and clients to protect the system from potential 
downtime due to viruses. However, be aware of the recommended restrictions.

You should exclude from the anti-virus scan any files found in the folders indicated below or with the extensions listed 
below.

 l C:\Program Files\Nuance\ and all sub-folders

 l C:\ProgramData\Nuance\ and all sub-folders

 l C:\<Windows user_ID>\AppData\ and all sub-folders

 l C:\Documents and Settings\All Users\Application Data\Nuance\ and all sub-folders

 l C:\Documents and Settings\Windows user_ID\Local Settings\Temp\

 l Files with these extensions: 
BD, BIN, DAT, DVC, ENH, GSB, GRM, GRX, INI, LCK, NWV, SIG, SVC, USR, VER, VOC, 
WAV, XML, LOG

Recommended virtual memory settings
Nuance recommends that you set virtual memory to the levels specified below on servers and workstations in the 
Dragon Group network. 

Server Virtual Memory

Nuance recommends that the virtual memory for all servers be set to three times the physically installed RAM.

Dragon Client Workstation Virtual Memory

Set Virtual Memory to 4092, or to the maximum possible setting on workstations that have 4 GB of RAM.

Required Skills for Installing Dragon Group
Before you begin the installation, you should evaluate your own system installation skill set. To select the appropriate 
hardware and install the Dragon Group software, you should have adequate skills and experience to:

 l Create a network domain/user account with full read/write access rights across all servers

 l Set Windows user rights and directory permissions

 l Edit XML configuration files
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Setting up the Nuance Management Server to Run Active Directory Services
Optionally, you can use Active Directory Services to manage your Dragon Group network. If you do not want to use 
Active Directory, you can skip to “Initial Installation of the Dragon Client” on page 26.

Note: Because enabling Active Directory Services requires specific steps during the Dragon Group 
installation process, it is best if you decide to use Active Directory Services before you install the Dragon 
Clients. However, it is possible to enable Active Directory Services after you have installed the Dragon 
Group network.

Creating an NMC Administrator account for Active Directory
To create the NMC Administrator account for the Active Directory administrator:

 1. Log in to the Nuance Management Console. For details, see “Logging in to the Nuance Management Console” 
on page 4.

 2. Before you set up user accounts required for Active Directory, in the NMC:

 l Change the name of the default Organization to your Organization’s name. See details on modifying the 
Organization information in the Nuance Management Server Administrator Guide under “Finding and 
managing organization data.”

 l Change the name of the default Site in that organization to your Site's name. See details on how to edit a 
Site in the Nuance Management Server Administrator Guide under “Configuring a site in your facility.”

 3. On the Menu bar, click on User Accounts:

 4. In the User Accounts ribbon, click the Add icon. The User Account Details window opens.

 5. Configure the settings in the tabs: 

14
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 l Details—The highlighted text boxes indicate required data (First Name, Last Name and Login). You can fill 
in the other fields later, if desired. 

Caution:  

The Login you enter must match a login that exists in Active Directory.

 l Address—Enter the user’s physical address (not required).

 l Group Memberships—Add the Active Directory administrator to a Group.

 l Messaging: Configure email settings to enable the NMS to send messages to users and administrators 
(not required).

 l Dragon Professional—Configure user settings in the Dragon Client. For now, you can skip this step – the 
default settings will be applied. For more information, refer to “Configuring user settings” in the Nuance 
Management Server Administrator Guide. 

 l User Profile—Ignore these settings. They will be provided by the Dragon Client.

 6. Click Save to save the user account settings.

 7. When you save the user account, you will see a dialog box displaying the available licenses: 

 8. Check NMC Administrator. The number of licenses available is shown in parentheses after the license type. 
If no licenses of a particular type are available, that type of license is grayed out. If no administrator licenses are 
available, contact your Nuance representative.

 9. You can create other user accounts at this time, or you can create them later. Make sure every NMS user 
account login you assign matches an existing login in Active Directory. For details on creating user accounts, 
see “Creating user accounts” in the Nuance Management Server Administrator Guide.

Note: The original admin user that Nuance provided will not work within Active Directory. After you have 
completed the steps above, log out of the NMC, then log in using the NMC administrator user account 
you created for the Active Directory administrator. You can now revoke the NMC administrator license of 
the original admin user and grant that license to another user account.

Set the Active Directory Connection String
 1. In the NMC menu bar, click Sites, then click the Organization Overview icon. Click on the name of the 

organization that you want to configure, then click the Details icon in the Organizations area at the top of the 
screen: 

15
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 2. The Organization Details screen appears. Click the Domains tab:

 3. Click Add. The Domain dialog box appears.

 4. Enter the domain name in the Name field, and the Active Directory connection string for that domain in the 
Active directory connection strings field:

 5. Click Save.

 6. Repeat steps 3-5 as needed for every domain that you want to set up.

Once Active Directory is on, NMS in the Cloud sends all authentication requests to the server you specified in the 
Active directory connection strings field. You can then set up and manage your network using Active Directory 
Services. 

For information on using Active Directory Services, refer to the documentation Microsoft provides. 

16
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Configuring User Accounts for Active Directory
When you implement Active Directory Single Sign-On, end-users are automatically logged in to Dragon when they 
have logged in to Windows. This allows end-users to avoid entering their login and password multiple times.

During the process of creating user accounts in the NMC (see “Creating user accounts” in the Nuance Management 
Server Administrator Guide), you will need to configure your user accounts to work with Active Directory. 

Single Sign-On user logins
Each user login must exactly match that user’s Windows Domain login. 

Note: If the login credentials for an existing user account do not match the user’s Windows login, you 
must delete the user account and create a new one.

On the User Account Details screen (click User Accounts in the menu bar, then click the Add icon), enter the user’s 
Windows Domain login name in the Login field:

For example, enter “John_Doe” in the Login field if the user’s Windows Domain login name is one of the following:

 l “Domain\John_Doe”

 l “John_Doe@domain.example.com”

After you have installed the Dragon Client, follow the steps in “Associating Dragon with the Nuance Management 
Server or Local Authenticator” on page 41. Be sure to set the Login Options radio button to Use Windows Single 
Sign-On. 

Active Directory user credentials
Complete the following steps in the User Account Details screen for each user you want to configure for Active 
Directory authentication.

17
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 1. In the Credentials tab, click the NTLM tab:

 2. Click Add to add a new domain mapping. The New NTLM Credential dialog appears:

 3. The User name and Organization name are automatically filled in. Use the Domain dropdown to choose the 
user’s domain, and enter that user’s login for the selected domain in the Login field.

 4. Click Save to close the dialog.

18
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About the Local Authenticator
If you want to use Active Directory Single Sign-On for your authentication with NMS in the Cloud, you must install the 
NMS Local Authenticator. 

NMS in the Cloud cannot test Active Directory credentials inside your organization. The NMS Local Authenticator fills 
this gap by testing Active Directory credentials. If they pass verification, the Local Authenticator sends the credentials 
to NMS in the Cloud for processing.

Install the Local Authenticator on a local server that is accessible to both NMS in the Cloud and your Dragon Clients. 
Once a client authenticates with the Local Authenticator, NMS in the Cloud is used for all other client requests, using 
the session the client was granted during authentication.

If you want to use Dragon’s native authentication, you do not need to install the Local Authenticator. Skip to “Initial 
Installation of the Dragon Client” on page 26.

Before you begin
 l You will need an organization token (see below).

 l You must configure the user accounts that will use Local Authenticator to use Active Directory login credentials. 
See “Active Directory user credentials” on page 17 for instructions.

 l You must have administrator privileges on the machine where you are installing the Local Authenticator.

 l You must have the latest version of the Microsoft .NET framework installed on the machine where you are 
installing the Local Authenticator.

Creating Organization Tokens
To install the Local Authenticator, you will need to enter an organization token. Complete the following steps to create 
an organization token:

 1. In the Nuance Management Console, go to Sites > Organization Overview. 

 2. Select the organization that you want to create a token for, and in the Organizations area at the top of the 
screen, click Details:

 

 3. The Organization Details screen appears. In the Organization Tokens tab, click Add to generate a new 
organization token:

 4. The Organization Token Info dialog pops up. The Organization Token field is pre-filled. Optionally, enter a 
value in the Comment field:
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 5. Click Save.

 6. The new token appears in the Organization Token table. Copy or make a note of this value.
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Installing the Local Authenticator
On the machine where you are installing the Local Authenticator:

 1. Find and run the .exe file for the Local Authenticator, which ships with Dragon Group. 

 2. A dialog will appear asking you to select a language for the installation. Use the dropdown to select the 
language, then click OK. 

 3. The InstallShield Wizard opens. Click Next to continue:
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 4. In the Customer Information dialog, leave the default value in the User Name field and enter your company 
name in the Company field. Click Next to continue.

 5. Set the location where the Local Authenticator will be installed, then click Next to continue.
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 6. Enter the organization token in the Token field and click Next to continue.

 7. Click Install to install the Local Authenticator.
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 8. A status dialog appears, with a status bar showing you how the installation is progressing. When the 
installation is complete, the InstallShield Wizard Complete dialog appears. Click Finish to exit the installer.

Configuring the Local Authenticator
Complete the following steps to configure the Local Authenticator:

 1. Open the folder where the Local Authenticator is installed. By default, the Local Authenticator is installed in: 

C:\Program Files\Nuance\Local Authenticator

 2. In any text editor, open NMS.LocalAuthenticator.Service.exe.config. This is the Local 
Authenticator configuration file.

 3. Find the line "<add key="NMSServerAddress" value="<NMS in the Cloud>"/>" and change the 
value to the address of NMS in the Cloud. You should have received this address in your welcome information.

 4. Save your changes to the configuration file.

 5. Start the NMS Local Authenticator service.

Local Authenticator logs

The Local Authenticator uses the same service trace logs as NMS in the Cloud. These logs can be found in:

C:\ProgramData\NMS\Logs
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Install Dragon on an Initial Computer and Choose the Default Settings
The initial installation is used to set default values for the Administrative, end-user, and Auto-Formatting options. 
These options can then be used to install on other computers using the same values.

Even if you are installing from a server, you should run through the initial installation below first. For more information 
on installing from a server, see “Overview of Installing the Dragon Client with Initial Settings” on page 35.

Caution:  

To change Administrative Settings, be sure you have Windows administrator privileges. Administrator rights are not 
required to create a user profile or to use the software after installation.

Before you begin

 l Install any pending Windows updates and reboot the computer when you are finished.

 l Close all open applications.

 l Turn off or disable anti-virus software; the installation process can sometimes trigger a false virus report.

Installation methods

Choose one of the following methods for performing the initial installation:

 l “Initial Installation Using the Dragon InstallShield Wizard” on page 28 (Recommended)

 l “Installation Using the Dragon Command Line” on page 30
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Initial Installation Using the Dragon InstallShield Wizard
The most straight-forward method for performing an initial installation of the Dragon Client is by running the 
setup.exe file on your installation DVD.

Perform the following steps to use the Dragon InstallShield Wizard:

 1. Insert the product DVD. If the installation does not start automatically, run setup.exe from the DVD.

 2. Follow the prompts to move through the installation.

 3. When you reach the Region Selection screen, choose the appropriate region(s), then select the Advanced 
checkbox to customize your settings.

 4. In the Advanced screen, select the following checkboxes to display additional dialog boxes at the end of the 
installation. These dialogs allow you to choose settings that apply to all end-users dictating on this computer. 
You can then copy these settings to other installations (see step 6).

 l Modify the application’s settings for all user profiles: Displays the Options dialog box at the end of the 
installation.

 l Modify the administrative settings: Displays the Administrative Settings dialog box at the end of the 
installation. 

 l Auto-Formatting options: Displays the Auto-Formatting dialog box at the end of the installation.

 5. When each of the dialogs you selected appears, select options to apply to all client installations, then click OK:

 l Options: Select the default options for correction, hot keys, data storage, and other settings. 

Notes:  

 l Settings under the Playback/Text-to-Speech tab are not saved. To include Text-to-Speech as a 
feature of your installation, see “Feature Variables to Set Through the ADDLOCAL or ADVERTISE 
Properties” on page 99.

 l At least one supported third-party indexing/search software should be installed on the system before 
you install Dragon, or the Enable Desktop Search commands checkbox will not only be unchecked, 
but will not be available to be checked. Dragon supports Google Desktop and Microsoft Search.

 l NMS users: Only options in the Commands tab will be saved to the NMS. All other settings in the 
Options dialog are saved locally.

 

 l Auto-Formatting: Select Auto-Formatting options to apply to all client installations.

Note: NMS administrators can also control these settings in the Nuance Management 
Console.

 l Advanced: Select default settings as needed in the following tabs:

 l NMS Settings: Check Enable NMS and enter the appropriate settings to allow the workstation to 
communicate with NMS in the Cloud.

Note: You cannot enable NMS on end-users’ machines via the Nuance Management 
Console.
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 l Scheduled Tasks: Enable and schedule Accuracy Tuning and (Stand-Alone mode only) Data 
Collection tasks.

 l Miscellaneous: Set other options for the Dragon Client.

Note: Some settings are disabled for NMS users; you can control these settings in the 
NMC.

 l Roaming (Stand-alone mode only): Enable and set up Roaming user profiles. For details, see 
“Setting Roaming User Profile Options” on page 107.

 6. Dragon saves the configuration you created during setup in nsdefaults.ini. If you set up your installation 
for Roaming user profiles, you will also find a file called roamingdef.ini. You can find these files under 
C:\ProgramData\Nuance\NaturallySpeaking14. 

The .ini file(s) contains custom settings that you can apply to each of the Dragon installations you deploy. 
Retrieve nsdefaults.ini (and roamingdef.ini, if applicable) and copy to a directory you can access 
from the other client computers. 

Note: If you want to add or change settings in the .ini files after you complete your initial installation, 
see “Natspeak.exe Command Line Options” on page 31. Otherwise, proceed to “Overview of Installing 
the Dragon Client with Initial Settings” on page 35.
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Installation Using the Dragon Command Line
If you prefer, you can perform an initial installation of Dragon through an elevated command prompt in Windows.

Windows elevated command prompts
To open an elevated command prompt, follow the steps below for your operating system:

 1. Windows 7: Select Start > All Programs > Accessories.

Windows 8 or 8.1: From the Start screen, select the down arrow to show all apps, then scroll to the right to view 
the Windows System apps. 

Windows 10: Select Start > All apps > Windows System. 

 2. Right-click Command Prompt and select Run as administrator. 

Command line installation with setup.exe
Perform the following steps to perform an initial installation using the Dragon command line:

 1. Open a command prompt window in administrator mode. 

 2. Insert the installation DVD and search for the directory where setup.exe is located. In the command prompt, 
switch to this path.

 3. Enter the following command line to install Dragon on this initial computer:

setup.exe /i /v"INSTALLDIR=C:\<full_path>\Nuance\NaturallySpeaking14 /L*v 
C:\Logs\logfile.log /qf"

Note: Unless you plan to use the Dragon Client on the machine you used for the initial installation, 
you do not need to enter a serial number. If you see errors regarding the serial number, you can 
ignore them.

The /v option introduces any series of msiexec.exe options you want to pass to the Windows installer. Be sure to 
enclose all options in quotation marks, directly after the /v as shown above. For more information on MSI options, 
refer to the Microsoft website: http://msdn.microsoft.com/en-us/library/aa367988(v=vs.85).aspx. The command line 
above sets the following options:

 l INSTALLDIR — Indicates the full path to the folder where you want Dragon installed.

 l /L*v — (not case sensitive) Indicates the log file where messages about the installation should be written. 

 l /qf — Shows the full Dragon installation GUI. Recommended for initial installations to help determine any 
problems with the command line.

For details on msiexec.exe installation options, see “MSI Options for Dragon Installations” on page 94.

Running natspeak.exe to set options
When the installation completes, proceed to the next section to set up the configuration for this initial installation. You 
can apply this configuration to all your installations.
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Natspeak.exe Command Line Options
When the installation completes, set up the configuration for this initial installation by following the steps below. 

These switches are used in the following syntax:

natspeak.exe /<switch>

<switch> is one or more switches below (each switch is a single word without spaces or hyphens).

To use natspeak.exe:

 1. On a workstation PC where Dragon is installed, close Dragon if it is running.

 2. Open a Command Prompt window:

 l Windows 7: Start > All Programs > Accessories > Command Prompt

 l Windows 8.x: From the Start screen, click the down arrow to show all apps > scroll to Windows System > 
Command Prompt

 l Windows 10: Start > All apps > Windows System > Command Prompt

 3. Switch to the program directory. The default is:

C:\Program Files\Nuance\NaturallySpeaking14\Program

 4. Enter the commands below to change the default configuration. All steps are optional; if you skip a step, your 
installation will use the default values for the associated options.

 l To open the Options dialog box, enter the command line:

natspeak.exe /SetDefaultOptions

In the dialog box, select the default options that should apply to all client installations, then click OK. 

Notes:  

 l Settings under the Playback/Text-to-Speech tab are not saved. To include Text-to-Speech as a 
feature of your installation, see “Feature Variables to Set Through the ADDLOCAL or ADVERTISE 
Properties” on page 99.

 l At least one supported third-party indexing/search software should be installed on the system before 
you install Dragon, or the Enable Desktop Search commands checkbox will not only be unchecked, 
but will not be available to be checked. Dragon supports Google Desktop and Microsoft Search.

 l NMS users: Only options in the Commands tab will be saved to the NMS. All other settings in the 
Options dialog are saved locally.

 

 l To open the Auto-Formatting dialog box, enter the command line:

natspeak.exe /SetDefaultFormattingOptions

In the dialog box, select Auto-Formatting options to apply to all client installations and click OK.

Note: NMS administrators can also control these settings in the Nuance Management 
Console.

 l To open the Administrative Settings dialog box, enter the command line:

natspeak.exe /SetDefaultAdministrativeOptions
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In the dialog box, select settings to apply to all installations in the tabs:

 l NMS Settings: Check Enable NMS and enter the appropriate settings to allow the workstation to 
communicate with NMS in the Cloud.

Note: You cannot enable NMS on end-users’ machines via the Nuance Management 
Console.

 l Scheduled Tasks: Enable and schedule Accuracy Tuning and (Stand-Alone mode only) Data 
Collection tasks.

 l Miscellaneous: Set other options for the Dragon Client.

Note: Some settings are disabled for NMS users; you can control these settings in the 
NMC.

 l Roaming (Stand-alone mode only): Enable and set up Roaming user profiles. For details, see 
“Setting Roaming User Profile Options” on page 107.

 l Click OK when you are finished.

 5. The configuration you created running natspeak.exe is saved in nsdefaults.ini (and, if you configured 
Roaming users, roamingdef.ini). By default, you can find these files here: 

C:\ProgramData\Nuance\NaturallySpeaking14

Note: If you did not run natspeak.exe on the command line or specify settings while running the 
Dragon InstallShield Wizard (see “Initial Installation Using the Dragon InstallShield Wizard” on 
page 28), you will not find an nsdefaults.ini or roamingdef.ini file.

 6. When you have located the .ini files, verify that your option settings have been changed. Double-click the 
nsdefaults.ini file to open it in a text editor. You should see values defined for the options you changed.

 7. Include the newly created nsdefaults.ini file in your MSI package to distribute the file to all end-user 
workstations where Dragon is installed.

You are now ready to install the same configuration you just established here onto other computers. For more 
information on installing from a server, proceed to “Overview of Installing the Dragon Client with Initial Settings” on 
page 35.

Other natspeak.exe options
Use these options from the command line:

Switch Function

/About Shows the About dialog for the Dragon Client

/FindAppData Opens the AppData directory for the Dragon Client

/FindAppDataAllUsers Opens the directory where the .ini files are stored

/FindCustom Opens the Data Distribution directory specified in the Miscellaneous tab of the 
Administrative Settings dialog

/FindDragonLog Opens the directory that contains Dragon.log
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Switch Function

/FindSetupLog Opens the directory that contains the Dragon setup log (dgnsetup.log)

/FindUpgradeLog Opens the directory that contains the upgrade log

/Diagnose Runs Dragon in diagnostic mode and exits – information is saved to Dragon.log

/Quick Runs Dragon in QuickStart mode, a mode that starts Dragon without loading a user 
profile or any speech models on startup of your computer

/Trusted Opens the Dragon Client and performs a trusted login with Windows credentials 
(NMS only)

/User <username> 
<profile>

Logs in the user to the Dragon Client (NMS only)

/LogOut Logs out user (NMS only)

/SaveandShutDown Closes Dragon and saves user profile changes

/ShutDown Close Dragon without saving user profile changes

/Deactivate Deactivates the license for the current Dragon Client
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Overview of Installing the Dragon Client with Initial Settings
You can use command line installations to copy your initial Dragon settings to all your Dragon Client installations.

Before you install
Before installing the Dragon Client on end-users’ machines, be sure you have done the following:

 l Be sure you have the Dragon serial number (or the group serial number, if you are installing or upgrading Dragon on 
multiple networked computers).

 l Be sure all mapped drives you plan to use are mapped on each client computer where you are distributing the 
installation or upgrade.

 l Install any pending Windows updates on clients and reboot as needed before continuing.

 l Copy any .ini files you want apply to your installation to a central location so you can access them later.

Notes:  

 l If you chose Enable Desktop Search Commands on the Commands tab during the initial installation, you must 
install Google Desktop or Microsoft Search before installing Dragon; otherwise, Desktop Search Commands will 
not be enabled.

 l Enclose long path names containing spaces in quotation marks (be sure to escape the each quotation mark with a 
backslash: \" ).

 l You can use the /qn option to install the product in Quiet mode, where no GUI or other messages appear. To use 
the /qn option, add it to the end of the command line. Another option, the /passive mode, runs the entire 
installation unattended, but displays a progress bar. 

 l The first time you run any installation command line, you should use the /qf option rather than /qn. This allows 
you to see GUI prompts that help you determine any problems with the command line. 

 l To ensure that you receive messages about any errors that occur during the installation, pass /L and one or more 
sub-options, followed by a log file name. The installer will create a file containing any installation log errors and 
other messages related to the process. You can send the log file to technical support should any issues arise.

 l For more information on MSI options, refer to the Microsoft website: http://msdn.microsoft.com/en-
us/library/aa367988(v=vs.85).aspx.

 

Pushing client installation from a server
Dragon includes a native Windows Installer (MSI) that lets you install across a network to multiple client computers 
and customize your installations. You can use the included Dragon 14.msi (see “Command Line Installation with 
msiexec.exe” on page 39) or admininstall.bat file (see “Carrying Out an Administrative Installation with a .bat 
File” on page 38). 

Several servers support this type of network installation:

 l Windows Server 2008 R2 and 2012 x64

 l System Management Server (SMS)

 l Active Directory Services

For an administrative installation, the administrator creates an image of the installation program on the server and then 
configures the server to automatically push the application onto the client systems. You can also configure network 
installations to modify, repair, or remove an existing installation.
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Support for SMS and Windows Server with Active Directory
Systems Management Server (SMS) provides a mechanism for pushing application installations out from the server to 
client systems. SMS supports using the Windows Installer (MSI) to push installations on clients using Windows 7, 8 
or 10. SMS requires that a client application be installed on all client computers.

Active Directory Services is a feature of Windows Server 2008 and 2012. The Group Policy component of Active 
Directory Services includes a Software Installation snap-in that lets an administrator create a network installation. 
Administrators can use this feature to install software onto Windows 7, 8 and 10 clients.

Dragon supports the Active Directory Services Assign to Computers installation option. This option successfully 
installs the software when the computer is rebooted. Administrators can delay installation on Windows clients by 
enabling logon optimization for group policy; for this type of installation, an entry for the installation can be viewed in 
the event log after the first reboot. The installation is then performed on the second reboot. The installation takes place 
silently, and the software is installed for all end-users on the computer. When you perform a silent installation of 
Dragon, the installation process does not display any messages. To view installation messages, administrators 
should view the setup log.
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Install the Same Dragon Configuration on Multiple Computers
Follow the steps below to install with setup.exe in the command line of a single client machine. If you would like to 
use Dragon 14.msi instead, see “Command Line Installation with msiexec.exe” on page 39.

 1. Open a Command Prompt: 

 l Windows 7: Start > All Programs > Accessories > Command Prompt

 l Windows 8.x: From the Start screen, click the down arrow to show all apps > scroll to Windows 
System > Command Prompt

 l Windows 10: Start > All apps > Windows System > Command Prompt

 2. Insert the installation DVD and search for the directory where setup.exe is located.

 3. In the Command Prompt window, switch to the setup.exe directory.

 4. To install the configuration you created during the initial installation, enter a command line using the format 
shown below. Pass your Dragon serial number for the SERIALNUMBER option and the full path to your 
customized nsdefaults.ini file to the DEFAULTSINI option:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-## 
INSTALLDIR=\"C:\Program Files\Nuance\NaturallySpeaking14\" 
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\" 
/L*v C:\Logs\logfile.log"

Stand-Alone mode: If you would like to include Roaming user profile settings in your installation, see 
“Installing a Roaming User Profile Configuration on Additional Computer(s)” on page 114.

Notes:  

 l When you are using the setup.exe method, you must ensure that all flags/properties (SERIALNUMBER, 
DEFAULTSINI, /qn, etc.) are all with in the same quotes, directly after /v, without a space.

 l Enclose long path names containing spaces in quotation marks (be sure to escape the each quotation mark with a 
backslash: \" ).

 l See “MSI Options for Dragon Installations” on page 94 for details on the MSI options available for Dragon 
installations.
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Carrying Out an Administrative Installation with a .bat File
A straightforward way to install Dragon from the command line to a server is to carry out an administrative installation 
using a .bat file. A script for carrying out a full administrative installation is provided in the admininstall.bat file 
at the top of the directory structure on the DVD. 

Caution:  

Only advanced administrators should attempt any type of administrative installation.

To run the batch file, open a Command Prompt and enter admininstall.bat and follow it with the location of 
Dragon 14.msi.

Understanding the script in admininstall.bat
Below are some of the lines from the script in the admininstall.bat file, a batch file that decompresses setup files 
into a network location for installation using SMS or another service.

Near the top of the batch file, you will see the lines that check the parameters entered and, if the parameter passed is 
not acceptable, execute a routine that handles that situation:

:rem //Check and analyze input parameters
if .%1.==.. goto bad_args

If the arguments you pass when you enter the command are acceptable, the batch file sets the NETWORK_DNS_DIR to 
the location of Dragon 14.msi:

set NETWORK_DNS_DIR=%1%

When you run the admininstall.bat file, the file installs Dragon using a single line of code:

echo Installing Dragon...
setup.exe /a /s /v"/qb TARGETDIR=%NETWORK_DNS_DIR% /Liwmo!e+ %TEMP%\admin-
install.log"

The above code calls the setup.exe command and passes it:

 l /a – Indicates an administrative installation.

 l /s – Indicates a silent installation.

 l /v – Indicates msiexec options to follow, enclosed in quotation marks. The included options are:

 l /qb – Indicates a basic GUI display during the installation process.

 l TARGETDIR – Indicates the target directory for an administrative installation.

 l /L – Indicates what type of data should be included in the log and where the log will be saved. Since a silent 
installation of Dragon will not display any messages, check the setup log for any installation messages or 
errors.

When the installation of Dragon succeeds or fails, the batch file displays an appropriate message. The remainder of 
the file handles errors and cases where bad arguments are passed on the command line.

Modifying admininstall.bat
The admininstall.bat script includes a bare minimum of the options available. You can modify the file by adding 
to and changing the options you pass for installing Dragon. See “MSI Options for Dragon Installations” on page 94 for 
details on the MSI options available for Dragon installations.
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Command Line Installation with msiexec.exe
Another way to install Dragon from the command line on several client computers is to use the msiexec.exe 
program from Microsoft. You are required to use msiexec.exe instead of setup.exe if you are installing Dragon 
from a server across a network.

Finding the MSI Installer on the Dragon DVD
The compiled MSI file, Dragon 14.msi, is located on your installation DVD.

You can double-click on the .msi file to start the InstallShield Wizard. However, to take advantage of available 
command line options, you can pass the file name to the msiexec.exe command as the application to install by 
using the /i option:

msiexec.exe /i "Dragon 14.msi"

Install same configuration on additional computer(s)
 1. Open a Command Prompt:

 l Windows 7: Start > All Programs > Accessories > Command Prompt

 l Windows 8.x: From the Start screen, click the down arrow to show all apps > scroll to Windows 
System > Command Prompt

 l Windows 10: Start > All apps > Windows System > Command Prompt

 2. On your installation DVD, locate Dragon 14.msi and switch to that directory.

 3. Retrieve the customized nsdefaults.ini file from the computer where you carried out the initial installation.

 4. To install Dragon, enter a command line using the format below: 

msiexec /i "Dragon 14.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="<full_path>\nsdefaults.ini"
/L*v "C:\Logs\logfile.log" /qn

Notes:  

 l For an administrative installation, pass the /a option to msiexec rather than the /i option. You also need to pass 
the TARGETDIR option instead of the INSTALLDIR option.

 l Dragon setup is designed so that msiexec.exe can be run from an elevated command prompt in Windows. See 
“Windows elevated command prompts” on page 30 for instructions on opening an elevated command prompt in 
Windows 7, Windows 8 and Windows 10.

 l See “MSI Options for Dragon Installations” on page 94 for details on the MSI options available for Dragon 
installations.
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Associating Dragon with the Nuance Management Server or Local 
Authenticator
You can configure User, Group, Site and Organization settings in the Nuance Management Console (see the Nuance 
Management Server Administrator Guide for details). Then associate Dragon Clients with NMS in the Cloud to allow 
users to log in and access the settings you configured in the NMC.

To set up the Dragon Client to work with NMS in the Cloud:

 1. On the DragonBar, click Tools > Administrative Settings.

Note: You can also access the Administrative Settings dialog via the natspeak.exe command line 
options (see “Natspeak.exe Command Line Options” on page 31).

 2. If you see a warning dialog, click Proceed to close all user profiles and open the Administrative Settings dialog.

 3. Click the NMS Settings tab:

 4. Select the Enable NMS checkbox.
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 5. If you are running NMS in the Cloud with Active Directory for authentication, enter the address of the Local 
Authenticator in the Server field.

If you are using Dragon's native authentication, enter the address of the NMC in the Server field.

 6. Click the appropriate radio button in the Login Options field.

 l Choose Provide a login name and password if you are using Dragon native authentication.

 l Choose Use Windows single sign-on if you configured your users for Active Directory single sign-on 
authentication.

 7. Click Apply, then click OK to exit the Administrative Settings dialog.

Once the Dragon Client is connected to NMS in the Cloud, end-users can log in to the user account that an NMS 
administrator has created in the Nuance Management Console.

If the user has no existing profile, the New User Wizard will appear after sign-in. For details on setting up a new user 
profile, see “Working with user profiles” on the Dragon Help site.
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Using Acoustic and Language Model Optimizer and Scheduler Tools
Run the Acoustic and Language Model Optimizer Scheduler to: 

 l Optimize the acoustic files for a user profile

 l Optimize the language model for a user profile

 l Schedule one or both types of optimization to occur on a particular day or time at particular intervals

 l Enable or disable the scheduled optimizations

Checking the optimization status of a user profile
Dragon Group checks the optimization status of a user profile when it is loaded if:

 l The profile has never been loaded before

 l The “Learn from specific documents” and “Learn from sent e-mails” wizards have not run within one week of the 
profile’s creation

 l The “Learn from...” wizards have not run for six months

 l The Language Model Optimizer has not run in over two months

 l The Acoustic Optimizer has never run and at least one hour of recorded dictation is available

Keeping custom words up-to-date

Using Dragon’s support for custom words, especially contact names, can make dictating with Dragon faster and more 
precise. 

Note: Stand-Alone administrators can automatically distribute custom words, Vocabularies and 
commands to your end-users using the nsadmin.exe tool. For details, see the nsadmin Help file 
available in the Help folder of your installation directory (by default, C:\Program 
Files\Nuance\NaturallySpeaking14\Help).

When Dragon loads a user profile, Dragon examines how long it has been since the last time custom words were 
updated. Dragon will display the Personalize Your Vocabulary dialog box when:

 l The “Learn from...” wizards have not run within two days of creating a new profile

 l The “Learn from...” wizards have not run for one month or more (If the end-user dismisses the Personalize Your 
Vocabulary dialog, Dragon will display the dialog once a week until the wizards are run.)

The Personalize Your Vocabulary dialog box contains information about the last time the “Learn from specific 
documents” and “Learn from sent e-mails” wizards ran for the profile. Users can run these wizards from the dialog. The 
dialog also displays the total time required to run the wizards. 

Checking for user profile maintenance when saving a user profile

When an end-user saves a user profile or closes Dragon, Dragon checks to make sure that scheduled user profile 
maintenance has been performed recently. If not, an additional checkbox will appear on the Save dialog. The 
maintenance should only take an extra minute or two to complete and is always beneficial – especially when new 
custom words have been added.

Running the Acoustic and Language Model Optimizers from the DragonBar
If a user profile is open in the Dragon Client, you can run the Acoustic and Language Model Optimizer from the 
DragonBar (Non-Roaming profiles only):
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 1. Select Audio > Launch Accuracy Tuning. 

 2. If the end-user has not dictated and corrected recognized text since the last time the optimizer was run, you will 
receive a message that the Acoustic Optimizer does not need to be run. Click OK. The Acoustic and 
Language Model Optimizer will open with the Perform Acoustic Optimization option grayed out.

 3. Check the types of optimization you want to perform: Perform Acoustic Optimization (to optimize the 
acoustic files of the user profile), Perform Language Model Optimization (to optimize the language model of 
the user profile), or both.

 4. Click Go to start. The process may take some time to complete. 

 5. You will receive a message notifying you when the process has completed. Click Done. 

Running the Acoustic and Language Model Optimizer from the Start menu
You can also the Acoustic and Language Model Optimizer from the Windows Start menu without opening a user 
profile:

 l Windows 7: Select Start > All Programs > Dragon > Dragon Tools > Acoustic and Language Model 
Optimizer Scheduler.

 l Windows 8.x: From the Start screen click the down arrow to show all applications. Scroll to find Dragon, then find 
Acoustic and Language Model Optimizer Scheduler.

 l Windows 10: Select Start > All apps > Dragon > Acoustic and Language Model Optimizer Scheduler.

Notes:  

 l Only an administrator can run the Acoustic and Language Model Optimizer from the Start menu. 

 l For Roaming user profiles, the system administrator is responsible for running the Acoustic and Language Model 
Optimizer on the network location of the Master Roaming user profiles. You can install Dragon on the computer 
where the Master Roaming user profiles are located or on any computer that has network access to the Master 
Roaming user profiles, then run the Scheduler. Later, any optimizations that result from running these tools are 
copied to the Local Roaming user profile when Dragon synchronizes it with the Master Roaming user profile. 

 l If you want to optimize a Roaming user profile locally, disable Roaming and browse to the Master Roaming user 
profile location. You can now run the Acoustic and Language Model Optimizer as you would for a non-Roaming 
user profile. 

 

 1. The Acoustic and Language Model Optimizer will open, displaying a list of the user profiles stored in the default 
directory. To access a different directory, select File > Set User Directory. The Set a Directory Containing 
User Files dialog box opens:

 2. Enter the path to the directory, or click the Browse button and browse to the location of the user profiles or (for 
Roaming users only) Master Roaming user profiles, then click OK. If the user profiles you want to optimize 
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are located in multiple directories, you can later repeat the steps outlined here and change this directory to 
locate the additional user profiles.

 3. Select File > New Task. 

 4. The Windows user name and password dialog box opens. Enter your Windows user name and password, then 
click OK. 

Note: If you are logged in to a domain, you must insert the domain name in front of your user 
name. 

 5. The Select Frequency dialog box opens. Under Optimization, select Perform Acoustic Optimization, 
Perform Language Model Optimization, or both:
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 6. Under User Profile Information, select a user profile from the User Name dropdown list or, to select multiple 
user profiles, click the Multiple Users button to open the Select user profiles dialog box:

 l Use the Add and Remove buttons to move selected user profiles to the Selected end-users in this task 
list on the right. You can also click Add All to add all profiles in the selected directory, or Remove All to 
remove all user profiles from the list.

 l You change the order of the list by selecting a name and clicking the Move Up or Move Down button. 
When you are satisfied with the list, click OK to proceed.

 7. If you are running the Optimizer tasks for a single user:

 l In the Dictation Source text box, select an audio input device from the dropdown list.

 l In the Vocabulary text box, select a vocabulary from the dropdown list.

 8. Under Select Frequency and Start Date & Time, select how often and at what time you want the 
optimization to run, as well as the first date it should run.

 9. At the bottom of the dialog, click the Enabled (schedule task runs at specified time) checkbox to enable the 
optimization.

 10. Click Apply to apply the changes.

 11. Click OK to close the Select Frequency dialog box. The Acoustic and Language Model Optimizer 
Scheduler dialog box displays a list of the events scheduled in the right pane of its dialog box. You can create 
more than one optimization schedule for a single user profile. When you do, both optimization events appear in 
the schedule list.

 12. Click File > Exit to close the Acoustic and Language Model Optimizer Scheduler.
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Using the Convert XML to DAT Tool
You can use a text editor to edit custom commands in XML format. To restrict access to only Dragon end-users, you 
can convert your commands from XML format to DAT format. Dragon uses .dat files to store commands. 

Note: For more on creating custom commands, see “Creating and editing custom commands” on the 
Dragon Help site. For help with Structured Commands, see the Advanced Scripting Reference.

You can use the XML to DAT tool (mycmdsxml2dat.exe) to extract end-user-defined Dragon commands from an 
XML file. The tool writes the commands to a .dat file. 

Starting the Convert XML to DAT tool
 l Windows 7: Click Start > All Programs > Dragon > Dragon Tools > Convert XML to DAT.

 l Windows 8.x: From the Start screen, click the down arrow to show all applications. Scroll to find Dragon, then 
find Convert XML to DAT.

 l Windows 10: Click Start > All apps. Scroll to find Dragon, then find Convert XML to DAT.

The Convert XML to DAT tool starts in an MS-DOS window, listing the tool’s syntax.

Convert XML to DAT syntax
The convert XML to DAT tool (mycmdsxml2dat.exe) uses the following syntax:

mycmdsxml2dat.exe <dat-file-path> <xml-file-path> [options]

Parameters Type Description

<dat-file-path> Required The full path to the local copy of the current end-user's .DAT file (by default, 
C:\ProgramData\Nuance\NaturallySpeaking14\Data\enx\dat
)

<xml-file-path> Required The full path to the .XML file to be converted

-v Optional Validates the specified .xml file over the Internet with a Nuance DTD 
(Document Type Definition) file. Disabled by default.

Use the XML to DAT tool to convert data in an XML file
 1. Create an XML file that contains the commands to use with Dragon.

 2. On a command line, use mycmdsXML2DAT.exe with the syntax shown above to convert the XML file to DAT 
format.

 3. Use the nsadmin utility to copy the .dat file to the Data Distribution directory. For details, see the nsadmin 
Help file available in the Help folder of your installation directory (by default, C:\Program 
Files\Nuance\NaturallySpeaking14\Help).

The next time an end-user opens a user profile, Dragon incorporates the new commands from the .dat file into the 
user profile.

To distribute commands in the NMC, see “Working with Command Sets” in the Nuance Management Server 
Administrator Guide.
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Using the MyCommands Protection Utility
In Dragon Group, you can protect custom Text-and-Graphics, Step-by-Step, Macro Recorder, and/or Advanced 
Scripting commands by exporting them into a .dat file, then running the MyCommands Protection Utility included in 
your Dragon installation. After they are imported to the Dragon Client, end-users can use the commands, but cannot 
view or edit their source code or re-export the commands. As a result, the integrity of the commands remains intact.

To protect the commands in a .dat file:

 1. Make a backup copy of the unprotected .dat file and store it in a secure location. Once you protect the .dat 
file that you are distributing, you cannot make the file available for editing again.

 2. Open a command prompt.

 3. Change directories to the Program folder inside your installation directory. By default:

C:\Program Files\Nuance\NaturallySpeaking14\Program

 4. Enter the following on the command line:

protectcmds.exe <dat-file-path> <vendor-name> [<vendor-contact-info>]

If an end-user attempts to view, copy, or edit commands from a protected file, the following message appears:

The command was protected by <vendor-name>. 
Please contact <vendor-contact-info> for more information.

In the Command Browser, the same message appears as the Preview Content in Script mode.

Once you have protected the file, you can put it into the Data Distribution directory for distribution to multiple user 
profiles, then use the nsadmin command line tool. For details, see the nsadmin Help file available in the Help folder of 
your installation directory (by default, C:\Program Files\Nuance\NaturallySpeaking14\Help).

To distribute commands in the NMC, see “Working with Command Sets” in the Nuance Management Server 
Administrator Guide.
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Preparing to Upgrade Dragon
Export user profiles
Before you upgrade, consider exporting user profile(s) for safe-keeping in case you need to re-install the previous 
version of Dragon. 

 1. On the DragonBar, select Profile > Manage User Profiles. The Manage User Profiles dialog opens:

 2. Select the user profile that you want to export.

 3. Click the Advanced button and select Export from the menu that appears:

 4. When the Browse For Folder dialog box opens, navigate to the folder where you want to store the exported user 
profile (or create a new folder by clicking the Make New Folder button) and click OK.

 5. When a dialog box opens displaying a message indicating the export was successful, click OK.

 6. Repeat steps 2 through 5 for each set of user profiles you want to export.

 7. Click Close to exit the Manage User Profiles dialog box.

 8. In the operating system, navigate to the directory where you exported the user profiles. In that directory you will 
find a separate folder for each exported user profile, labeled with the user name.

For more information on exporting profiles, see “Working with user profiles” in the Dragon Help site.
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Note: Do not export profiles to a folder in the Dragon directory. These directories may be deleted if 
Dragon is uninstalled.

Optional: Export custom words
Your user profiles’ vocabulary may be enhanced by custom words or phrases the user added manually (through the 
Vocabulary Editor or the email and document analysis feature) and words Dragon learned during the process of 
correcting misrecognitions. 

Consider exporting any custom words to create a backup copy in case you need to re-install the previous version.

To check for custom entries in your vocabulary:

 1. From the DragonBar, select Vocabulary > Open Vocabulary Editor.

 2. Select Custom words only from the Display dropdown list:

If the user profile includes custom words, follow these steps to export them into a file:

 1. From the DragonBar, select Vocabulary > Export custom word and phrase list.

 2. In the Save window, specify a name for the list, then choose a format, .xml or .txt, in the Save As Type 
dropdown. By default, the custom words will be saved as a .txt file.

 3. Choose a Windows folder where you will store the file.

 4. Click Save.

Optional: Export custom commands 
If your user profiles contain custom commands (imported or created in Dragon), consider exporting them so that you 
have a backup of them in case you need to re-install the previous version.

To export custom commands into a file:
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 1. From the DragonBar, select Tools > Command Browser.

 2. In the Command Browser window, click the Mode menu, then select Manage.

 3. To export only custom commands, choose User-Defined in the Group dropdown menu:

 4. Click the plus sign (+) to expand the list of commands.

 5. Select the checkbox next to the commands you wish to export.

 6. Click the Manage menu, then select Export.

 7. In the Save window, specify a name for the file, then choose a Windows folder where you will store it.

 8. Click Save.
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Upgrading Roaming User Profiles
If you are upgrading from Dragon Professional version 12 or 12.5, you will need to upgrade your user profiles before 
using them. For Roaming user profiles, an administrator should upgrade the Master Roaming user profiles before 
upgrading the Dragon Clients. Version 13 or 13.5 profiles can be used without upgrading.

Before upgrading Roaming user profiles, recall some basics about how the Roaming feature works: Each Dragon end-
user has a Master Roaming user profile, which is stored on a network location that can be opened from any networked 
computer where Dragon is installed. When a Roaming user profile is opened, Dragon transfers a copy of the Master 
Roaming user profile to the end-user’s device.

Since the Local Roaming user profile is a copy of the Master Roaming user profile, it does not make sense to upgrade 
the Local Roaming user profile when upgrading the local Dragon installation.

Instead, install Dragon Group on the network computer where the current Master Roaming user profiles are located 
and upgrade the Master Roaming user profiles directly. After upgrading the Master Roaming user profiles, 
administrators can then proceed to upgrade end-user systems that deploy the Roaming feature.

Notes:  

 l Although the User Profile Upgrade Wizard supports both mapped drives and UNC paths, Nuance strongly 
recommends upgrading the Master Roaming user profiles on a computer where Dragon Group is locally installed. 
Upgrading over a network will take an undetermined length of time. In addition, the User Profile Upgrade Wizard 
does not support upgrading user profiles over an HTTP connection.

 l Plan to upgrade the Master Roaming user profiles at a time when they are not being opened by end-users – for 
example, during the night or on a weekend. If there is not a time when none of the Roaming user profiles are in 
use, you can upgrade different groups of Roaming user profiles at different times.

 l Nuance recommends backing up user profiles before upgrading them. Back up the Master Roaming user profiles 
to a separate location using any system backup utility that is implemented at your facility.

 

Before you upgrade
 1. Install or upgrade Dragon Group on the computer where the current Master Roaming user profiles are located. 

Note: If you cannot install Dragon where the current Master Roaming user profiles are located, 
Nuance recommends that you copy the current Master Roaming user profiles to a separate 
computer, install the upgraded version of Dragon Group on that machine, then continue the Master 
Roaming user profile upgrade. When the upgrade is complete, copy the Master Roaming user 
profiles back to the network-accessible directory.

Note: If the upgrade installation displays an option to upgrade existing user profiles to work with 
this installation in Dragon Professional 13.5 or earlier, ignore the option, as it does not affect 
Roaming user profiles. You will manually run the User Profile Upgrade Wizard later.

 2. NMS users: To upgrade Roaming user profiles, you must make sure that NMS is disabled for this installation 
of the Dragon Client. 

 a. On the administrator system where you will upgrade the Master Roaming profiles, start Dragon.

 b. On the DragonBar, click Tools > Administrative Settings.
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 c. In the NMS Settings tab, make sure Enable NMS is unchecked. You can re-enable NMS after you 
have upgraded your Master Roaming user profiles.

If you skip this step, you will need to go to the NMC and disable Roaming for the entire Site (see “Configuring 
the location of Roaming user profiles” in the Nuance Management Server Administrator Guide).

 3. On the central network location that stores the current Master Roaming user profiles, create a new directory to 
store the upgraded Master Roaming user profiles. Always be sure the upgraded user profiles are in a different 
location from the current user profiles. If end-users see two versions of each user profile, they may become 
confused when they try to open a user profile. 

 4. Disable the Roaming feature. If you skip this step, the Upgrade User Profiles Wizard will display an error 
message stating that you cannot upgrade a Roaming user profile.

 a. On the administrator system where you will upgrade the Master Roaming profiles, start Dragon.

 b. On the DragonBar, click Tools > Administrative Settings.
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 c. When the Administrative Settings dialog opens, click the Roaming tab and make sure Enable is not 
checked.

 d. Click OK, then close Dragon.

 5. Upgrade the Master Roaming user profiles using the Upgrade User Profiles Wizard (see “Upgrading User 
Profiles” on page 63). 

Since the User Profile Upgrade Wizard leaves the original Master Roaming user profiles unchanged and in their 
original network location, the Dragon Clients can continue to use the Roaming feature until you upgrade the systems. 
Follow the steps in “Upgrading with msiexec.exe” on page 61.

After upgrading Roaming user profiles
If you copied the Master Roaming user profiles to a separate computer for upgrading, make sure you copy the 
upgraded profiles back to the new network-accessible directory that you created to store them (see step 3).

After upgrading the Dragon Clients, remember to update the Roaming User Network Directories to point to new, 
upgraded the Roaming user profiles. For instructions, see “Setting the location of Master Roaming user profiles” in the 
Dragon Help site (for Stand-Alone users) or “Configuring the location of Roaming user profiles” in the Nuance 
Management Server Administrator Guide (for NMS users). 

57

http://www.nuance.com/products/help/dragon/dragon-for-pc/enx/professionalgroup/main/Content/GetStart1.htm


Dragon Installation Guide

Stand-Alone users: Be sure to enable the Roaming feature when you upgrade the Dragon Clients. See “Installing a 
Roaming User Profile Configuration on Additional Computer(s)” on page 114 for details on configuring Roaming user 
profiles during installation. 
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Upgrading Your Dragon Installation from the Command Line
There are two command line upgrade scenarios:

 l Major Upgrade—Upgrading to a new edition or version of Dragon Group.

 l Minor Upgrade—Upgrading to a higher point release within the same edition and version of Dragon. 

Minor upgrades do not support the silent (no GUI) upgrade option. When you run setup.exe with a GUI to install a 
minor upgrade, setup.exe can detect when a previous version of Dragon exists on a target computer. Once it 
detects a previous version, setup.exe runs the rest of your installation in minor upgrade mode, automatically 
overwriting older files with newer files and adding any missing files. 

Note: Since a silent installation of Dragon will not display any messages, check the setup log for any 
installation messages or errors.

Upgrading with settings
Although the upgrade does not migrate forward the configuration or Roaming user profile settings from the earlier 
version, you can install with your previous settings using one of the following methods:

 l Reuse the nsdefaults.ini and (Stand-Alone users only) roamingdef.ini files you used when you first 
installed Dragon Group. 

 l Perform an initial installation of the new version of Dragon on a single computer (see “Installation Using the 
Dragon Command Line” on page 30) and establish the configuration you want to use by calling natspeak.exe 
on the command line (see “Natspeak.exe Command Line Options” on page 31).

Administrators cannot upgrade user profiles during the command line installation. 

For Roaming user profiles, upgrade the profiles in the Master Roaming user profile directory before you upgrade the 
Dragon Clients (see “Upgrading Roaming User Profiles” on page 55). Upgraded Roaming user profiles will become 
available as soon as Dragon is updated on the client computers.

For non-Roaming user profiles, run the User Profile Upgrade Wizard after installation completes. See “Upgrading User 
Profiles” on page 63 for details on the User Profile Upgrade Wizard.

Upgrading from the command line
Before you begin your upgrade: 

 l Be sure you have the Dragon serial number (or the group serial number, if you are installing or upgrading Dragon on 
multiple networked computers).

 l Be sure all mapped drives you plan to use are mapped on each client computer where you are distributing the 
installation or upgrade.

 l Install any pending Windows updates on clients and reboot as needed before continuing.

 l Copy any .ini files you want apply to your installation to a central location so you can access them later.

Using setup.exe for silent upgrades
When you use the command line, you must use the REINSTALL=ALL option and set REINSTALLMODE to the sub-
options you want to reinstall, generally REINSTALLMODE=vamus. If you did not originally install in the default location, 
make sure you use the INSTALLDIR option to point to your installation directory. Here is an example command line 
using setup.exe:

setup.exe /s /v"/i "Dragon 14.msi"
SERIALNUMBER=#####-###-####-####-##
REBOOT=ReallySuppress
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INSTALLDIR=\"C:\Program Files\Nuance\NaturallySpeaking14\"
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
REINSTALL=ALL REINSTALLMODE=vamus
/L*v C:\logfile.log /qn"

Note: When you are using the setup.exe method, you must ensure that all flags/properties 
(SERIALNUMBER, DEFAULTSINI, /qn, etc.) are all with in the same quotes, directly after /v, without a 
space. See “MSI Options for Dragon Installations” on page 94 for details on the MSI options available for 
Dragon installations.
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Upgrading with msiexec.exe

Note: When you use the msiexec.exe installer to uninstall Dragon from a command prompt, the 
installer automatically retains user profiles from the previous version of Dragon. After upgrading, end-
users can upgrade their local (non-Roaming) user profiles when they start Dragon. To upgrade Roaming 
user profiles, see “Upgrading Roaming Users” on page 55.

The table below lists GUIDs that you pass to the /x option of msiexec for each version of Dragon and Visual C++ 
Runtime for Dragon. Make sure to use the /x option with the GUID. 

Products and versions GUID

Dragon Group {FEAB6184-0560-4EBF-A26BC3F2B11FE9E1}

DNS V13 {33EA20FB-5389-4938-BA59-2BCD9BB68F41}

DNS V12 {D5D422B9-6976-4E98-8DDF-9632CB515D7E}

VC-Runtime 32-bit {4A5A427F-BA39-4BF0-9A47-9999FBE60C9F}

VC-Runtime 64-bit {4A5A427F-BA39-4BF0-9A47-7777FBE60C9F}

Step-by-Step Upgrade Process

Note: See “MSI Options for Dragon Installations” on page 94 for details on the MSI options available for 
Dragon installations. For more information on MSI options, refer to the Microsoft website: http://msdn.-
microsoft.com/en-us/library/aa367988(v=vs.85).aspx.

You must follow these steps to set options for your end-users:

 1. Open a command line window as an administrator (see “Windows elevated command prompts” on page 30).

 2. To uninstall the current version of Dragon with msiexec.exe, pass the installer the /x option followed by the 
old version’s GUID (shown in the table above) and the /qn option to turn off any GUI.

For example:

msiexec /x {33EA20FB-5389-4938-BA59-2BCD9BB68F41} /L*v "C:\updatelog.log" 
/qn

Include /L*v "C:\updatelog.log" if you want to create a log of the uninstall and/or update process. You 
can change "C:\updatelog.log" to a different location or file name.

Caution:  

The first time you run any installation command line, you should use the /qf option rather than /qn. This 
allows you to see GUI prompts that help you determine any problems with the command line. 

 3. Install the new version of Dragon with msiexec.exe by passing the installer the /i option followed by the 
name of the Dragon .msi file and installation options you want to include.

 l For a major upgrade, pass REMOVEOLDPROD=1. This tells the installer to look for previous versions of 
Dragon and uninstall them. If no previous version of Dragon is found, the installation will continue. In 
addition, pass DEFAULTSINI and set it to the full path to your modified nsdefaults.ini file. For 
example:

msiexec /i "Dragon 14.msi"
SERIALNUMBER=#####-###-####-####-## 
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REBOOT=ReallySuppress
INSTALLDIR="C:\Program Files\Nuance\NaturallySpeaking14"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
REMOVEOLDPROD=1 /L*v "C:\logfile.log" /qn

 l For a minor upgrade, install the new version of Dragon with msiexec.exe as you would the major 
upgrade, but pass REINSTALL and REINSTALLMODE options, as shown in the sample below:

msiexec /i "Dragon 14.msi"
SERIALNUMBER=#####-###-####-####-## 
REBOOT=ReallySuppress
INSTALLDIR="C:\Program Files\Nuance\NaturallySpeaking14"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
REINSTALL=ALL REINSTALLMODE=vamus
/L*v "C:\logfile.log" /qn

Here, REINSTALL is set to ALL and REINSTALLMODE is set to vamus.

For more information on the REINSTALL and REINSTALLMODE settings, refer to “MSI Options for Dragon 
Installations” on page 94.

Caution:  

If you do not pass the REINSTALL and REINSTALLMODE options, the minor upgrade will fail.

If you are using Roaming user profiles in Stand-Alone mode, be sure to include your roamingdef.ini file 
(see “Installing a Roaming User Profile Configuration on Additional Computer(s)” on page 114).

 4. After the installation of Dragon is complete, perform the steps below.

Edit the NSSYSTEM.INI file

After you install Dragon using a script, you must edit the nssystem.ini file so that Dragon can find existing profiles 
from the previous version and launch the Upgrade User Profile Wizard when the end-user opens Dragon.

Edit the nssystem.ini from the machine where you performed the installation. Do not copy the nssystem.ini file 
from a different computer where you installed Dragon. 

 1. Navigate to C:\ProgramData\Nuance\NaturallySpeaking14.

 2. Use a text editor like Notepad to open the nssystem.ini file.

 3. In the nssystem.ini file, in the [Settings] section, add the following line:

Old Users Directory=<path to previous Dragon version profiles>

 4. Save the nssystem.ini file.
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Upgrading User Profiles
If your organization used Dragon Professional version 12 or 12.5, you will need to upgrade your user profiles before 
using them. Version 13 or 13.5 profiles can be used without upgrading.

When you upgrade the Dragon Client, the Upgrade User Profiles Wizard will launch when the end-user first attempts 
to open a version 12 or 12.5 user profile. The Upgrade User Profiles Wizard walks users through the process of 
upgrading profiles stored on the local machine. For Roaming user profiles, an administrator should upgrade the Master 
Roaming user profiles before upgrading the Dragon Clients (see “Upgrading Roaming User Profiles” on page 55).

You can also run the Upgrade User Profiles wizard from the Start menu:

 l Windows 7: Click Start > All Programs > Dragon > Dragon Tools > Upgrade User Profiles

 l Windows 8.x: From the Start screen, click the down arrow to show all apps. Scroll to Dragon, then find Upgrade 
User Profiles

 l Windows 10: Click Start > All apps > Dragon > Upgrade User Profiles

Note: Although the User Profile Upgrade Wizard supports both mapped drives and UNC paths, Nuance 
strongly recommends upgrading the Master Roaming user profiles on a computer where Dragon Group is 
locally installed. Upgrading over a network will take an undetermined length of time.

Running the Upgrade User Profiles Wizard
 1. On the Select the profile(s) to upgrade page, you will see a list of any user profiles stored in the default 

directory. To upgrade other profiles, click Browse to add a profile and select the location of the user profiles 
to be upgraded. The Select the profile(s) to upgrade page now displays all user profiles in the selected 
directory or directories:
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Click Browse to add a profile to add user profiles from other local folders or Remove from list to remove 
specific user profiles. Click Next to continue.

 2. If you choose to upgrade only one user profile, the wizard will confirm the user to be upgraded and the estimated 
time required.

 3. (Optional for non-Roaming users) On the Choose where to store the upgraded profile(s) page, under 
Location for upgraded profile(s), choose the directory where you want to store upgraded user profiles. If no 
location is visible, click the Browse button and find the correct location.
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 4. (Optional) Click Advanced if you would like to select a new Base Vocabulary or Acoustic Model for one or more 
of your upgraded user profiles.

Click OK when you are done to return to the Choose where to store upgraded profile(s) page.

 5. Click Next to proceed.

 6. The Begin profile upgrading page displays the number of user profiles that the wizard is prepared to upgrade. 

Click Begin upgrading to start the upgrade process. The upgrade process can take 12-24 minutes or more per 
user profile, depending on the speed of the computer system. Click Stop at any time to interrupt this process. 

 7. Click Finish to complete the upgrading process and exit the User Profile Upgrade Wizard.

The upgrade process creates new user profiles in the destination you selected. 

Importing custom words and commands
If you are using Stand-Alone mode, you will need to import any custom words and commands your user profiles 
included. These are not automatically included in the user profile upgrade.

 l To distribute words and commands to all users, you can use the nsadmin.exe tool. For details, see the nsadmin 
Help file available in the Help folder of your installation directory (by default, C:\Program Files\Nuance\Nat-
urallySpeaking14\Help). 

 l To manually import words and commands to individual Dragon Clients, see “Exporting and importing a list of 
custom words and phrases” and “Exporting and importing commands” in the Dragon Help site.
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Dragon Logs 
Dragon Group generates logs that can help troubleshoot your system. If you call Technical Support, you might be 
asked to provide one or more of these logs to help Nuance engineers work on any issues with your network.

NMS in the Cloud users can view additional logs in the Nuance Management Console (see the “View log files for a 
variety of products and product components” section in the Nuance Management Server Administrator Guide). 

Note: Dragon regularly purges all logs and does not automatically back them up. If you want to save your 
logs for longer periods, back them up to another location.

Dragon Client logs
The Dragon Client creates log files, dragon.log and dgnsetup.log, which you can view on the end-user’s 
machine:

C:\ProgramData\Nuance\NaturallySpeaking14\logs\<WindowsUser>

You can also access this directory through a shortcut in the Start menu:

 l Windows 7: Click Start > All Programs > Dragon > Show Setup Log or Show Dragon Log

 l Windows 8.x: From the Start screen, click the down arrow to show all applications. Scroll to find Dragon, then 
find Show Setup Log or Show Dragon Log.

 l Windows 10: Click Start > All apps > Dragon> Show Setup Log or Show Dragon Log

Note: If you do not see the Show Dragon Log or Show Setup Log shortcuts in the Start menu, try 
logging out, then logging back in again.

The current Dragon log filename is Dragon.log. When this file exceeds 10 MB, it is appended with the date and time 
in the format Dragon_YYYYMMDD_HHMMSS.log and a new log file is created.

The hour is shown in 24-hour format. For example, Dragon_20150820_155023.log is the name of a log created on 
August 20, 2015 at 15:50:23 (or 3:50:23 PM).

Dragon stores the last 10 log files.

Manually creating a new Dragon log file

An administrator can start a new Dragon log file when Dragon starts.

 1. Open text editing software such as Notepad. On Windows 7, Windows 8.x, and Windows 10, make sure you 
have administrator rights when you open the text editor (use the “Run as administrator” option to open the text 
editor).

 2. In the text editor, navigate to the folder that contains the nssystem.ini file. The default location of the 
nssystem.ini file is:

C:\ProgramData\Nuance\NaturallySpeaking14

 3. In the text editor, open the nssystem.ini file.

 4. In the [Settings] section, add the following line of text: New Log On Startup=1. 

 5. Save and close the nssystem.ini file.

 6. To activate the setting, re-open the user profile.
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Usability logs (Stand-Alone mode only)
You can set up Dragon to create a usability log that logs all menu commands, toolbar buttons, and voice commands 
that you use during a dictation session.

To set up a usability log:

 1. With a user profile open, on the DragonBar, select Tools > Options.

 2. Click the Data tab.

 3. Click the Advanced button. 

 4. When the Advanced dialog box opens, check the Create usability log checkbox and click OK to return to the 
Data tab.

 5. Click Apply, then click OK to close the Options dialog box.

By default, the log is located here: 

C:\Users\<Windows_user>\AppData\Roaming\Nuance\NaturallySpeaking14
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Handling Dragon Error Messages
When Dragon displays an error message:

 1. Read the message carefully. It may give you enough information to determine what to do.

 2. If you dictated text into your document, click Close to close the error message box and then save your 
document.

 3. Do not save your user profile.

 4. Copy the error message log file (Dragon.log) to a safe place. Technical Support may ask you to send this file 
for further study. In Dragon Group, the Dragon.log file is located in the following directory:

C:\ProgramData\Nuance\NaturallySpeaking14\logs\<WindowsUser>

 5. Exit Dragon and start it again. In some cases it may be necessary to restart your computer.

 6. Insert your Dragon DVD into your DVD reader, run the installation program again, and choose the Repair option 
on the first screen of the Dragon setup program. After setup finishes, reinstall any Dragon patches that were 
previously installed.

 7. If the error message does not provide enough information to determine what to do, search our website for 
information on the error message. You may find a solution that can save you time and trouble:

http://www.nuance.com/product-support/default.asp?lang=us&prod=dn
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Accessing the Dragon Knowledge Database
Solutions to known problems with Dragon are provided at the Nuance Knowledge Base, located at http://nuance.-
custhelp.com/.

 1. In the search field, type keywords related to your problem, 

 2. Click the magnifying glass to start the search.

For an Advanced Search, click Advanced Search, then fill in some or all of the following fields in the popup window 
that appears:

 1. Select your product in the dropdown list in the Limit by product field.

 2. Refine your product by version number and edition as needed (for example, Dragon NaturallySpeaking > 14 > 
Dragon Professional).

 3. In the Limit by Category dropdown list, select a category to further refine the search criteria.

 4. In the Sort by direction field, choose whether results should be sorted in ascending or descending order.

 5. Click Search.
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Use Dragon through a remote desktop connection

Tasks to perform Topic associated with the task
Overview of how client users can remotely connect to Dragon through a 
remote desktop connection.

Remote desktop connection support

Install Dragon on the server and install Dragon Client For Remote Desktop Installing Dragon software on the server 
and the client

Set up the Windows server options Configuring the Windows server
Set up client computers by setting audio policies  and the Remote Desktop 
Connection 7.

Configuring the Dragon clients
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Remote desktop connection support
You can use Dragon through a remote desktop connection with the following operating systems:

Server Operating Systems Description Client Operating 
systems 

Windows Server 2008 R2 and Windows 
Server 2012 R2

Supports multiple client connections at the 
same time.

 n Windows 10, (32-bit 
and 64-bit)

 n Windows 8, (32-bit 
and 64-bit)

 n Windows 7, (32-bit 
and 64-bit)

Windows 7 Ultimate and Enterprise Server Supports only a single client connections 
at one time.

Windows 10 Professional, Enterprise and 
Education

Supports multiple client connections at the 
same time.

Windows 8 Professional and Enterprise Supports multiple client connections at the 
same time.

Windows Server 2012R2 and 2008 Supports multiple client connections at the 
same time.

 

In order to transmit audio from the client computer to Windows Server 2008 R2, Windows Server 2012 R2, or 
Windows 7 Ultimate Server running Dragon Group, you must:

 l enable the audio recording option on the remote client software

 l enable the audio recording redirection policy on the server

This configuration allows one Windows client computer to access and use a single installation of Dragon Group on the 
server.

Support for dictation sources over a remote desktop connection
In Dragon Group, you can use the following dictation sources over a remote desktop connection:

 n USB microphones

 n Other microphones: Microphone plugged into Mic-In jack

 n Headset: Andrea NC-181

 n Bluetooth: Plantronics Calisto Bluetooth Headset

Using Dragon Group on Windows Server 2008 R2, Windows Server 2012 R2, or Windows 7 Ultimate Server:

 l The Remote Audio suggested for the user profile will be the default microphone on your client computer.

 l If you are using the Remote Application web interface - When you launch Dragon Group from the Remote Desktop 
Connection, if you launch the DragonBar in Docked-to-Top or Docked-to-Bottom mode, the Dragon menus will not 
be visible.  To access the menus, you need to switch to work with Floating, Clinging, or the Tray Icon mode.

System Requirements for using Dragon through a remote desktop connection
 n Server Operating System: Windows Server 2008 R2, Windows Server 2012 R2, or Windows 7 Ultimate Server

Window Server 2008 R2 and Windows Server 2012 R2 support multiple client connections at the same time. 
Windows 7 servers supports only a single client connections at one time.          

 n Client Operating System: The following operating systems support Remote Desktop Connection 7:

 n Windows 10, 32-bit and 64-bit

 n Windows 8.x, 32-bit and 64-bit

73



Chapter 11: Using Dragon over a remote desktop connection

 n Windows 7,  32-bit and 64-bit

 n Client Hardware:

 n Disk space: 

 n 2 MB for the Remote Desktop Client version 7 (from Microsoft )

 n 8 MB for the Dragon client

 n USB port for the microphone

 n Server Hardware: To support 6 concurrent users connecting to Dragon Group  on a server, the minimum 
requirements are:

 n Cache: 1 MB L2 cache per CPU

 n CPU:  3.x Ghz

 n Disk space: 5 GB

 n Processor: Multi-core processor with 4 cores

 n RAM: 16 GB DDR2 RAM

 n Microphone: 

 n USB microphones: including the PoweMic

 n Other microphones: Microphone plugged into Mic-In jack

 n Headset: Any Nuance-approved headset. For details, visit http://support.nuance.com/compatibility/ to view 
the Hardware Compatibility List.

 n Bluetooth: Plantronics Calisto Bluetooth Headset

 n Software: 

 n Remote Desktop Connection 7 (RDP 7). The RDP 7 download is available here, and works for all operating 
systems:              http://support.microsoft.com/kb/969084 

 n Network:

 n 100 Mbps connection speed 

 n Network bandwidth required per active user is 1.3 Mbps
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Installing Dragon on the  server and the client
To enable audio redirection through a remote desktop connection, and allow users to connect and use Dragon Group 
on Windows Server 2008 R2, Windows Server 2012 R2, or Windows 7 Ultimate Server, you install and configure 
software on both the client computers that will connect to Dragon on the server, and on the server machines. You can 
expect to spend around thirty minutes installing and configuring the required software.

Perform the following steps:

 1. Install Dragon on  Windows Server 2008 R2, Windows Server 2012 R2, or Windows 7 Ultimate Server.  
You can also perform remote dictation from Windows 7 Enterprise and Windows 7 Ultimate servers. For 
Windows Server 2008 R2 and Windows Server 2012 R2, it is possible for multiple users to connect at the same 
time. For Windows 7 servers, only a single client can connect at a time.

 2. Install the Dragon Client For Remote Desktop on each client computer that will connect to Dragon on a server.  

If you are installing Dragon Client for Remote Desktop using the MSI Windows Installer, run 
dragonclientinstaller.msi; otherwise, run setup.exe. These files are located on the Dragon DVD in the 
"DragonClientForRemoteDesktop" folder.

  The Dragon Client For Remote Desktop installation consists of two components that you install on the client 
computer:

 l Audio Setup Wizard: a stand-alone application that provides a way to check that your 
microphone sound levels and signal quality are suitable for using Dragon Group with a 
remote desktop connection. 

 3. Proceed to Configuring the Windows server.
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Configuring the Windows server
 1. Ensure the server computer meets the system requirements. See System Requirements  for more information.

 2. On Windows Server 2008 R2, Windows Server 2012 R2, or Windows 7 Ultimate Server, make sure that the 
"Remote audio" recording device already exists.

 3. If you are using Windows Server 2008 R2, perform the steps in Configuring Remote Desktop Connection for 
Windows Server 2008 R2.

 4. If you are using Windows Server 2012 R2, perform the steps in Configuring Remote Desktop Connection for 
Windows Server 2012 R2. 

 5. If you are using Windows 7 Ultimate Server, perform the steps in Configuring Remote Desktop Connection for 
Windows 7 Ultimate Server.

 6. Optionally, you can publish all applications and EMRs on Windows Server 2008 R2, Windows Server 2012 R2, 
or Windows 7 Ultimate Server using Remote Application Manager. This provides full support for dictation and 
playback

 7. If you are using Windows 10, see How to use Remote Desktop on the Microsoft site (http://win-
dows.microsoft.com/en-us/windows-10/how-to-use-remote-desktop)

 8. Proceed to Configuring the client computer to connect to Dragon through a remote desktop connection.
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Configuring Windows Server 2008 R2
Perform the following steps to install and configure the Remote Desktop Services role.

 1. Open Remote Desktop Connection.

 2. Open the Server Manager.

 3. Select  Roles.

 4. Select Add Roles.

 5. On the Before You Begin screen, click Next.

 6. On the Select Server Roles screen, select Remote Desktop Services, click Next.

 7. On the Remote Desktop Services screen,  click Next.

 8. On the Select Role Services screen, select Remote Desktop Session Host, click Next.

 9. On the Uninstall and Reinstall Applications for Compatibility screen,  click Next.
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 10. Select Do not require Network Level Authentication , click Next.

 11. On the Specify Licensing Mode screen, click Next.

 12. Click Next.
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 13. Select the Audio and video playback option and the Audio recording redirection option and click Next.
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 14. Confirm your selections, and click Install.

The Installation Progress screen display the status of the installation. 

 15. On the Installation Results screen, verify that the installation was successful. Click Close.

 16. Restart the computer.

Perform the following steps to configure the local group policy on the server and to allow connections from client 
computers.

 1. On the server, in a command prompt, run gpedit.msc.

 2. Navigate to Computer Configuration > Administrative Templates > Windows Components > Remote 
Desktop Services > Remote Desktop Session Host > Device and resource redirection.

 3. Enable the Allow audio and video playback redirection option: on the Allow audio and video playback 
redirection screen, select Enabled and Press OK. 

 4. Enable the Allow audio recording redirection option: on the Allow audio recording redirection screen, 
click Enabled and Press OK.

 5. Launch regedit on the client PC and set the following registry setting to 0:
HKLM\SYSTEM\CurrentControlSet\Control\Terminal Server\WinStations\RDP-Tcp 
fDisableAudioCapture     REG_DWORD     0x00000000

 6. On the server, open the Control Panel.

 7. Navigate to System and Security > System.

 8. Select Remote.
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 9. Allow remote  connections by choosing your preferred configuration.

 10. Click OK.

 11. Continue at step 5 in Configuring the client computer to connect to Dragon through a remote desktop 
connection.
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Configuring Windows Server 2012 R2 Part 1
 1. Open Remote Desktop Connection to the server or go directly to the server console.

 2. Open the server, open the Server Manager.

 3. On the Dashboard, select Add roles and features to open the Add Roles and Features wizard.

 4. Click       Before You Begin and click Next.

 5. Select Role-based or feature-based installation and click Next
.

 6. On the Select destination server screen, select Select a server from the server pool.Select the server and 
click Next
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 7. On the Select Server Roles screen, select Remote Desktop Services, click Next.

 8. On the Select features screen, open the Remote Server Administration Tools submenu.

 9. Open the Role Administration Tools submenu.

 10. Open the Remote Desktop Services Tools submenu.

 11. Select Remote Desktop Licensing Tools and click Next.

 12. On the Remote Desktop Services screen,  click Next.

 13. On the Select role services screen, select Remote Desktop Session Host.

84



Dragon Installation Guide

 14. On the next screen, click Add Features and then click Next.
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 15. On the Confirm installation selections screen, check the Restart the destination server automatically if 
required option.

 16. In the Add Roles and Features wizard, click Yes.

 17. Confirm your selections, and click Install.

 18. The Installation Progress screen displays that status of the installation.

 19. On the Installation progress screen, verify that the installation was successful.

 20. Click Close.

 21. Restart the computer (even if the server was not restarted automatically).

Perform the following steps to configure the local group policy on the server and to allow connections from client 
computers.

 1. On the server, in a command prompt, run gpedit.msc.

 2. Navigate to Computer Configuration > Administrative Templates > Windows Components > Remote 
Desktop Services > Remote Desktop Session Host > Device and resource redirection.
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 3. Enable the Allow audio and video playback redirection option: right-click on the Allow audio and video 
playback redirection screen and choose Edit.

 4. Select Enabled and click OK.

 5. Launch regedit on the client PC and set the following registry setting to 0:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Terminal 
Server\WinStations\RDP-Tcp 
fDisableAudioCapture     REG_DWORD     0x00000000

 6. On the server, open the Control Panel.

 7. Navigate to System and Security > System.

 8. Select the Remote settings > Remote tab.

 9. Allow remote  connections by choosing your preferred configuration.

 10. Click OK.

 11. Continue at step 5 in Configuring the client computer to connect to Dragon through a remote desktop 
connection.
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Configuring  Windows 7 Ultimate Server
 1. On the Windows 7 Ultimate Server, open the Control Panel.

 2. Open System Properties.

 3. Click the Remote tab.

 4. Allow remote  connections by choosing your preferred configuration.

 5. Proceed to Configuring the client computer to connect to Dragon through a remote desktop connection.
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Configuring the Dragon clients
After you install Dragon Group on the server and Dragon Client for Remote Desktop on each client computer, perform 
the following steps on each client computer that will connect to Dragon Group on the server.

 1. Ensure the client computer meets the system requirements. See System Requirements  for more information

 2. On  the client, plug in the microphone that you will use to dictate with Dragon Group. Then run the Audio Setup 
Wizard to check that microphone sound levels and signal quality are suitable. 

 3. Ensure Remote Desktop Connection 6.1 (RDC 6.1) or higher is installed on the client computer. If it is not, visit 
the following link to download Remote Desktop Connection 7.0 client update                http://sup-
port.microsoft.com/kb/969084.

 4. When you start Remote Desktop Connection 7, in the Remote Desktop Connection dialog box, click Options. 
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 5. Select the Local Resources tab, click Settings.

 6. Select Play on this computer  and  Record from this computer, and click OK. Selecting these options 
enables audio support  each time the user opens the remote connection to use Dragon Group on Windows 
Server 2008 R2 or Windows Server 2012 R2.
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 7. In the Windows sound settings, verify that Remote Audio device appears.

User Profiles and using Dragon through a Remote Desktop session
Dragon users must perform four minutes of Short training when they create a User Profile. It is not possible to skip 
User Profile training when Dragon Group is installed on Windows Server 2008 R2, Windows Server 2012 R2, or 
Windows 7 Ultimate Server and when using Remote Desktop Connection 7. 

Dragon users can Use Profiles created on Dragon workstations without performing additional training on Windows 
Server 2008 R2, Windows Server 2012 R2, or Windows 7 Ultimate Server.

Nuance recommends that you create and train a User Profile (or add a dictation source to an existing User Profile) 
while Dragon is running in a Remote Desktop session. If an end-user uses an existing profile with a dictation source 
that was trained while Dragon was running on the end-user’s workstation, poor accuracy may result. 
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MSI Options for Dragon Installations
This section describes the msiexec.exe options that apply to Dragon Group. For more information on MSI options, 
refer to the Microsoft website: http://msdn.microsoft.com/en-us/library/aa367988(v=vs.85).aspx.

Notes:  

 l Launching msiexec.exe /i "Dragon 14.msi" <PROPERTY>=<VALUE> automatically sets the specified 
<PROPERTY> to <VALUE> and continues the installation. However, if you use setup.exe to install, you must 
put all msiexec.exe options in quotation marks after the /v option:

setup.exe /v"<PROPERTY>=<VALUE>"

 l Be sure that the values that you pass to the MSI are valid. Entering an invalid value can cause the installer to 
crash.

 l Dragon command line options do not need to be prefaced by hyphens or slashes.

 l In Dragon Group, the installation process does not present the QuickStart option. If you wish to enable this option, 
you can do so after Dragon is installed.

 l Unless noted otherwise, all property values are in UPPERCASE.

Options Description

DEFAULTSINI="c:<path>\
nsdefaults.ini"

Indicates a default settings file (nsdefaults.ini ) that the installer 
uses to change the product settings for all end-users at installation 
time. This file must be in an .ini file format; any settings you want 
to include must have a section name encased in square brackets as 
well as the value and data. If the section name is missing, the 
settings are not propagated on client computers. 

Generally, you should not edit the nsdefaults.ini file directly; 
instead, set defaults in Dragon’s Options and Administrative 
Settings dialog boxes during your initial installation, then use the 
nsdefaults.ini from that installation.

For details, see “Install Dragon on an Initial Computer and Choose the 
Default Settings” on page 27.

ROAMINGUSERINI="c:<path>\
roamingdef.ini"

Indicates a default settings file (roamingdef.ini) used to 
configure Roaming network settings. 

For more information about Roaming user settings, see “Setting 
Roaming User Profile Options” on page 107.

SERIALNUMBER=abcde-fgh-ijkl-
mnop-qr

A serial number is required for all installations. You must specify a 
valid serial number on the command line. 

Note: Specifying a serial number on the command line does 
not bypass the serial number checking during Setup.

INSTALLDIR="<path to install>" Sets the installation directory to the specified location.

Note: For an administrative installation, pass the 
TARGETDIR option instead of the INSTALLDIR option.
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Options Description

REBOOT=ReallySuppress Prevents the computer where you are installing Dragon from 
rebooting automatically after the installation ends.

SETDEFAULTS=0/1 Sets the default state of the Modify the application’s settings for 
all users checkbox in the Advanced dialog of the Installer (see page 
28 for details).

0: Checkbox is not selected; the installer will not display the Options 
dialog unless the user checks the box. 

1: (Default) Checkbox is selected; the installer will display the 
Options dialog when the installation process completes unless the 
user unchecks the box.

Note: If you use the /qn switch, no dialogs will display 
during installation, even if you set them to display in the 
command line.

SETADMINS=0/1 Sets the default state of the Modify the administrative settings 
checkbox in the Advanced dialog of the Installer (see page 28 for 
details).

0: Checkbox is not selected; the installer will not display the 
Administrative Settings dialog unless the user checks the box. 

1: (Default) Checkbox is selected; the installer will display the 
Administrative Settings dialog when the installation process 
completes unless the user unchecks the box.

Note: If you use the /qn switch, no dialogs will display 
during installation, even if you set them to display in the 
command line.

SETFORMATTINGS=0/1 Sets the default state of the Modify the formatting options for all 
users checkbox in the Advanced dialog of the Installer (see page 28 
for details).

0: Checkbox is not selected; the installer will not display the Auto-
Formatting dialog unless the user checks the box. 

1: (Default) Checkbox is selected; the installer will display the Auto-
Formatting dialog when the installation process completes unless the 
user unchecks the box.

Note: If you use the /qn switch, no dialogs will display 
during installation, even if you set them to display in the 
command line.

PERIODIC_TASK=<tasks>;<admin>;
<password>;<Day>, <hh:mm>

Configures the Acoustic Model Optimizer, Language Model Optimizer 
and (Stand-Alone only) Data Collection tasks in the Scheduled 
Tasks tab of the Administrative Settings dialog.
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Options Description

See “MSI Options for Scheduled Tasks” on page 102 for details.

REGION=<region> Set the REGION to include with your installation. For English-
language installations, available regions are:

 l United States (UnitedStates or US)

 l Canada (Canada)

 l United Kingdom (UnitedKingdom or UK)

 l Australia/New Zealand (Australia or NewZealand)

 l Indian subcontinent (IndianSubcontinent or Indian)

 l Southeast Asia (SoutheastAsia or Asia)

To install all English-language regions, set REGION=All. 

Set REGION=NoEnglish or REGION=None if you do not wish to 
install any English-language regions.

ADDLOCAL=Feature1,Feature2,...
or 

ADDLOCAL=ALL

Set the ADDLOCAL property to a comma-delimited list of features to 
be installed locally. See “Feature Variables to Set Through the 
ADDLOCAL or ADVERTISE Properties” on page 99 for a list of 
available features.

To install all features locally (including user profiles), use 
ADDLOCAL=ALL.

ADVERTISE=Feature1,Feature2,... Set the ADVERTISE property to a comma-delimited list of features to 
be available but not locally installed. 

The ADVERTISE option overrides the ADDLOCAL option. The best 
method for installing a particular set of features is to set the 
ADDLOCAL property to ALL and then set the ADVERTISE property to 
those features you do not want installed locally. 

REINSTALL=Feature1,Feature2,... 

or 

REINSTALL=ALL

Set the REINSTALL property to a comma-delimited list of features to 
be reinstalled. 

To reinstall all features, use REINSTALL=ALL.

If you set the REINSTALL property, you should also set the 
REINSTALLMODE property to indicate the type of reinstall to be 
performed.

Note that even if REINSTALL is set to ALL, only those features that 
were already installed previously are reinstalled. 

REINSTALLMODE={type of 
reinstallation to perform}

Set the REINSTALLMODE property to a string indicating the type of 
reinstall to perform. Options are case-insensitive and order-
independent. 

For a list of available modes, see https://msdn.microsoft.com/en-
us/library/windows/desktop/aa371182. 

The default is REINSTALLMODE=omus. The installer will overwrite 
files if they are missing or an older version, rewrite required registry 
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Options Description

entries, and reinstall all shortcuts and icons.

REMOVEOLDPROD=1 Set REMOVEOLDPROD to 1 to remove the old version of the product 
before installing the new version. You should on only use this option 
for major upgrades.

/x<Product.msi|ProductCode> Uninstalls the currently installed version of Dragon. You are required 
to take this action during upgrading; however, you should be familiar 
with the entire upgrade procedure before proceeding with this option. 
See “Upgrading with msiexec.exe” on page 61 for applicable product 
codes.

/L<parameter> "<full 
path>\logfile.log"

Creates an installation log in the specified location. To log all 
information, including verbose output, enter /L*v. You can send this 
log to technical support should any issues arise.

For available parameters, see https://technet.microsoft.com/en-
us/library/cc759262(v=ws.10).aspx#BKMK_SetLogging

/q<parameter> Sets the user interface level for the installation. 

For an initial installation, pass the /qf option to ensure that you see 
GUI prompts that will help you diagnose any issues that arise.

Use /qn for a silent installation.

For available parameters, see https://technet.microsoft.com/en-
us/library/cc759262(v=ws.10).aspx#BKMK_SetUI

NAS_ADDRESS="<Production server 
URL>"

(NMS Installations only)

Indicates the NMS address that the Dragon Client connects to when 
the user logs on. You should have received this address in your 
welcome email.

NAS_WINDOWS_LOGIN=0/1

(NMS Installations only)

Sets the Login Options radio button state in the NMS tab of the 
Administrative Settings dialog.

Note: Before you enable Active Directory single sign on, you 
must make additional configuration changes in order for the 
feature to work. See “Setting up the Nuance Management 
Server to Run Active Directory Services” on page 14 for 
more information.

0: (default) Disables Active Directory single sign-on; sets radio button 
to Provide a login name and password.

1: Enables Active Directory single sign-on; sets radio button to Use 
Windows single sign-on.
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Sample command lines
msiexec.exe command line

msiexec.exe /i "Dragon 14.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\Program Files\Nuance\NaturallySpeaking14" 
PRODUCTUPDATEFLAG=1 REBOOT=ReallySuppress
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"
ADDLOCAL=TTSENX,NatSpeak,ENUGeneral
/L*v "C:\Logs\logfile.log" /qn

setup.exe command line

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\Program Files\Nuance\NaturallySpeaking14\"
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"
ADDLOCAL=TTSENX,NatSpeak,ENUGeneral
/L*v C:\Logs\logfile.log /qn"

98



Appendix A: Options for MSI Installations

Feature Variables to Set Through the ADDLOCAL or ADVERTISE Properties
When specifying features on the command line:

 l If a feature does not exist in a particular edition or language, overriding its default property has no effect.

 l Some features (such as Text-to-Speech) have sub-features.  Setting these features on the command line 
automatically turns on the properties of all sub-features, unless you specify an additional override for those sub-
features.

You can specify any of the features in the table below using ADDLOCAL and ADVERTISE properties on the command 
line. For example:

ADDLOCAL=TTSENU,NatSpeak,ENUGeneral

Feature Sub-features

NatSpeak

Note: Required in ADDLOCAL; if not 
included, the installation will fail.

None

Samples

(Sample Commands file)

None

TTS

(Text-to-Speech)

 l TTSENU (US English Text-to-Speech)

 l TTSENG (British English Text-to-Speech)

 l TTSDEU (German Text-to-Speech)

 l TTSESP (Spanish Text-to-Speech)

 l TTSFRA (French Text-to-Speech)

 l TTSITA (Italian Text-to-Speech)

 l TTSNLD (Dutch Text-to-Speech)

Tutorial  l TutENX (English Tutorial)

 l TutDEU (German Tutorial)

 l TutESP (Spanish Tutorial)

 l TutFRA (French Tutorial)

 l TutITA (Italian Tutorial)

 l TutNLD (Dutch Tutorial)
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Speech options

Feature Sub-features: Vocabularies Supported accents

ENU

(US English)

 l ENUGeneral (US English General 
Medium, US English Empty 
Dictation, US English Commands 
Only)

 l ENULegal (US English Legal 
Large)

 l ENUGenSvc (US English Large 
General)

 l Standard 

 l Australian accented English

 l British accented English

 l Indian accented English

 l Pakistani accented English

 l Southeast Asian accented English

 l Southern US

 l Spanish accented English

 l Teens

 l Accent not otherwise specified

Canada

(Canadian English) 

 l CanadaGeneral (Canadian 
English General Large)

 l Standard

 l Australian accented English

 l British accented English

 l Indian accented English

 l Pakistani accented English

 l Southeast Asian accented English

 l Southern US

 l Spanish accented English

 l Teens

 l Accent not otherwise specified

ENG

(UK English)

 l ENGGeneral (UK English General 
Large, Empty Dictation General, 
Commands Only)

 l Standard

 l Australian accented English

 l Indian accented English

 l Southeast Asian accented English

 l Accent not otherwise specified

DEU

(German)

 l DEUGeneral(German General 
Large, Swiss German General, 
Empty Dictation General)

 l DEULegal (German Legal)

N/A

ITA

(Italian)

 l ITA (Italian General Large and 
Italian Empty Dictation General 
Large)

N/A

NLD  l NLDGeneral (Dutch General 
Large and Dutch Empty Dictation 

N/A
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Feature Sub-features: Vocabularies Supported accents

(Dutch) General Large)

FRA

(French)

 l FRAGeneral (French General 
Large, French Empty Dictation 
General Large)

N/A

ESP

(Spanish)

 l ESP (Latin American Spanish 
General Large, Latin American 
Spanish Empty Dictation General 
Large, Castilian Spanish General 
Large)

N/A
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MSI Options for Scheduled Tasks

Note: Take the following actions on the client computer, not on the computer where you performed the 
initial installation and configured default option settings for end-users.

You can include an additional option on the command line to run one or more of the following tasks on a particular 
schedule:

 l Acoustic model optimization (ACO) — This task optimizes the acoustic models used to interpret the end-
user’s speech. You can set a particular date and time for this optimization to occur. When a speaker is new to 
Dragon, you might want to run the optimization more often.

 l Language model optimization (LMO) — This task optimizes the language model (vocabulary files) used to help 
recognize words that the end-user speaks. The model incorporates data from the end-user’s speech into the 
language model he or she is using, customizing the model for that user profile.

 l Data collection (DC) — This task automatically collects data that helps improve Dragon’s ability to recognize 
speech. You can choose to allow this data to be sent back to Nuance over the Internet on a particular schedule or 
choose not to send the data. This process does not collect your personal information. Data collection is available 
in non-US English versions of Dragon Group.

Note: When NMS is enabled, you cannot schedule Data Collection tasks on the Dragon Client 
machines. NMS administrators can schedule Data Collection in the NMC. See “Turning on data 
collection for your site” in the Nuance Management Server Administrator Guide for details.

You can schedule the above tasks and turn them on or off by passing an option called PERIODIC_TASK to the MSI 
installer. 

First, set PERIODIC_TASK to a string containing short acronyms for the types of tasks, separated by vertical bars: 
aco | lmo | dc

If you do not pass the acronym for a feature, that feature is set to its default.

Next, the string for PERIODIC_TASK should include the administrator login and password, followed by the schedule 
for each task, in the order that they occur in the string, separated by vertical bars. 

 l Enter the day(s) of the week for each task using three-letter abbreviations (Mon, Tue, etc.). 

 l Enter the hour using a 24-hour clock in the format hh:mm (05:00, 18:30, etc.). 

For example, the string below sets the schedule for Acoustic Model Optimization to Mondays at 1 AM and the 
Language Model Optimization to Mondays at 6 AM:

PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"

The task runs once a week on the day and time indicated. If you omit the Day, the task runs every day at the time 
given. Because no schedule is specified for Data Collection, the default schedule will be used (Stand-Alone only).

Default Schedules

 l Acoustic model optimization (ACO) — Every day, 3 AM

 l Language model optimization (LMO) — Every day, 2 AM
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Editing Miscellaneous and Scheduled Task Settings in nsdefaults.ini 
Several settings from the Miscellaneous and Scheduled Tasks tabs of the Administrative Settings dialog box can be 
modified in the nsdefaults.ini file you created in “Initial Installation of the Dragon Client” on page 26. You can 
then pass the revised file to the DEFAULTSINI option (see “Install the Same Dragon Configuration on Multiple 
Computers” on page 37).

Note: Many of the settings below are not available when NMS is enabled in the Dragon Client. NMS 
administrators can control these settings in the NMC.

Options Description UI

AO Archive Time Limit

(Stand-Alone only)

Maximum audio archive size in 
minutes. The same option in the 
options.ini file for a particular end-
user contains the size of the current 
audio archive for that end-user.

Default max. is 3600000 minutes.

Archive Size dialog box, displaying the 
range of audio archive sizes

Disable command changes 
for restricted 
users=0/1

Turns on or off the option that lets non-
administrative end-users add or modify 
commands.

Miscellaneous tab: Do not allow 
restricted users to add or modify 
commands checkbox

Disable vocabulary 
changes for restricted 
users=0/1

(Stand-Alone only)

Turns on or off the option that lets non-
administrative end-users modify 
vocabularies.

Miscellaneous tab: Do not allow 
restricted users to modify 
vocabularies checkbox

Global Enable Pause 
Results=0/1

(Stand-Alone only)

Turns on or off recognition when the 
speaker pauses. 

Miscellaneous tab: Record wave 
data between utterances checkbox

Custom Directory=<full 
path>

(Stand-Alone only)

Sets the location of the Data 
Distribution directory used by the Data 
Distribution Tool or the nsadmin 
command.

Miscellaneous tab: Data 
Distribution location field

No Dictation=0/1 When No Dictation is on (set to 1) the 
end-user cannot dictate, but can 
correct dictation; used to designate an 
end-user as a transcriptionist.

Miscellaneous tab: Correction Only 
Mode checkbox

Global MyCommands 
MacroRecorder=0/1

(Stand-Alone only)

Allows or does not allow the end-user 
to modify Macro Recorder commands. 
The end-user can use Macro 
commands, even when not allowed to 
modify them.

Miscellaneous tab: Disable use of 
Macro Recorder commands 
checkbox

Global MyCommands 
StepByStep 
Scripting=0/1

Allows or does not allow the end-user 
to modify Step-by-Step commands. 
The end-user can use Step-by-Step 

Miscellaneous tab: Disable use of 
Step-by-Step commands checkbox
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Options Description UI

(Stand-Alone only) commands, even when not allowed to 
modify them.

Global MyCommands VBA 
Scripting=0/1

(Stand-Alone only)

Allows or does not allow the end-user 
to modify Advanced Scripting 
commands. The end-user can still use 
Advanced Scripting commands, even 
when not allowed to modify them.

Miscellaneous tab: Disable use of 
Advanced Scripting commands 
checkbox

enx ACO uses Auto 
Accent AM selection=0/1

(Stand-Alone only)

When set to 1, the Acoustic Optimizer 
engine can automatically select an 
acoustic model that it believes is more 
suited to your speech. To avoid having 
this switch occur, set the option to 0.

Miscellaneous tab: Disable 
automatic acoustic model selection 
in Acoustic Optimizer checkbox

Data Collector Batch 
Mode=0/1

(Stand-Alone only)

When set to 1, turns on a process that 
automatically collects data to help 
improve speech recognition in the 
future. The process sends recorded 
dictation and the corresponding text to 
Nuance over the Internet, but does not 
send any personal information. 

Collecting data for Nuance is optional.

Scheduled Tasks tab: Enable 
scheduled Data Collection 
checkbox

Allow Users to 
Optimize=0/1

When set to 1, automatically runs an 
optimization process on speech 
recognition for the currently open user 
profile.

Scheduled Tasks tab: Enable 
scheduled Accuracy Tuning 
checkbox

Allow Users to 
Configure Tasks=0/1

When set to 1, allows end-users to set 
the schedule for accuracy tuning and 
(for Stand-Alone users) data collection 
tasks. Otherwise, these tasks take 
place on a default schedule.

Let the user choose when to run 
Accuracy Tuning and Data Collection
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Extracting MSI/MST Files from the Dragon setup.exe
Some minor releases of Dragon do not include an MSI file. Instead, the file is part of the setup.exe file. You can run 
silent installations from the command line with msiexec.exe or setup.exe – you don’t need to extract the .msi 
and .mst files. Use the following information if you are comfortable using .msi installers.

Note: 
When you are using the setup.exe method, you must ensure that all flags/properties 
(SERIALNUMBER, DEFAULTSINI, /qn, etc.) are all with in the same quotes, directly after /v, without a 
space.

Using .MST files, you can tailor the MSI installation without changing the setup.exe file that Nuance provides.

The following sample command line extracts the Dragon 14.msi file and the .mst files used for installing Dragon:

setup.exe /a /s /v"EXTRACTFILES=c:\temp\MSIfiles /qn"

Use the options below to extract .msi/.mst files from setup.exe. These options do not install any files, but rather 
extract an installable set of files into the server directory you specify. You can then use the extracted .MSI and .MST 
files in a command line to install Dragon. 

Option Description

/a An administrative installation installs a source image of the 
application onto the network. For details, see https://msdn.-
microsoft.com/en-us/library/aa367541(v=vs.85).aspx.

/v"<msiexec options>" Passes msiexec options to Windows Installer. See “MSI 
Options for Dragon Installations” on page 94 for details. This 
option is required when extracting the .msi files.

EXTRACTFILES=C:\<fullpath>\ Indicates the directory where the extracted .msi/.mst files 
are to be written. Enclose long path names containing spaces 
in quotation marks (be sure to escape the each quotation mark 
with a backslash: \" ). This property is required to extract the
 .msi files. If the directory you specify does not exist, the 
installer creates it.

Here is a sample command line to extract .msi files from a 
single executable:

setup.exe /a /s /v"EXTRACTFILES-
S=c:\temp\msifiles"

/l<Windows Language Code> Creates an MST file for the language specified (for example, 
1031.mst). The language codes supported for installing 
Dragon are:

1031=German

1033=English

1034=Spanish

1036=French

1040=Italian

1043=Dutch
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Setting Roaming User Profile Options
Use the following steps to create a roamingdef.ini file to be used for an MSI installation where the Roaming 
feature is enabled:

 1. Install Dragon on a computer with Windows administrator privileges (see “Initial Installation of the Dragon 
Client” on page 26).

 2. In the Administrative Settings dialog box, accessed during installation or via the natspeak.exe commands 
(“Natspeak.exe Command Line Options” on page 31), click on the Roaming tab. 

 3. Enable the Roaming feature options required in your environment. You must include the Master Roaming user 
profile location, set in the Network Directories field, and any necessary HTTP or HTTPS settings. For details 
on configuring the Roaming feature, see “Administrative Settings dialog box – Roaming tab” in the Dragon Help 
site.

 4. Test these settings to make sure the Roaming user profile connection works.

 5. Configure settings in additional tabs as needed.

 6. Save your settings by closing Dragon.
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 7. Copy the encrypted roamingdef.ini or roaming.ini file (use whichever file is newer) and the 
nsdefaults.ini file created by this installation of Dragon to a separate location. By default, the .ini files 
are located in:

C:\ProgramData\Nuance\NaturallySpeaking14

108



Dragon Installation Guide

Understanding Roaming User Settings in nsdefaults.ini and roamingdef.ini 
The settings below were created when you configured Roaming in the previous topic. 

Roaming options set in nsdefaults.ini
You can edit these settings directly in the nsdefaults.ini file.

Option Description and UI equivalent

Roaming User On=0/1 Enable checkbox: Turns the Roaming feature on or off. 

Default 0 (unchecked) = Off

Roaming User Local 
Cache
Directory="<existing 
directory>"

Local directory (for cache) field: Sets the location of the local copy of the 
Roaming user profile. 

The default location is: C:\ProgramData\Nuance\Nat-
urallySpeaking14\RoamingUsers\

Open User Large 
Collection=0/1

Display Classic Open User Profiles dialog checkbox

Default 1 (unchecked) = Off

Roaming User Restrict 
Local User Access=1/0

Allow non-Roaming user profiles to be opened checkbox: Permits non-
Roaming user profiles to be opened when the Roaming feature is active. 

Default 1 (unchecked) = Access restricted to Roaming user profiles only. This 
setting can prevent end-users from accidentally selecting a non-roaming (local) 
user profile.

Roaming User 
Incorporate Voc 
Delta=0/1

Merge contents of vocdelta.voc into network user profile when file is full 
checkbox: When the vocdelta.voc file reaches 90% of its maximum size (1 
GB), incorporates the contents of the local vocdelta.voc file into the Master 
Roaming user profiles (acoustic model for the user profile), without running the 
Acoustic and Language Model Optimizer. After it incorporates the contents of 
the file into the Master Roaming user profile, it clears that data from the local 
user profile, where new data is pulled from subsequent dictation. If the data is 
being incorporated when you open a Roaming user profile, the process can be 
time consuming. 

Default 1 (checked) = On

Note: Dragon does not display a message when the vocdelta.voc 
file reaches 90% of its maximum size. 

Roaming User Limited 
Network Traffic=0/1

Access network at user profile open/close only checkbox: Synchronizes 
the Master and local Roaming user profiles only when an end-user opens or 
closes the profile. This includes the changes an end-user makes locally from the 
Options dialog box. 

Default 0 (unchecked)= Off

Excessive network slowdowns can be alleviated by checking this option 
because it limits multiple interim synchronizations of Local and Master Roaming 
user profiles. 
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Option Description and UI equivalent

Roaming User Always 
Break Lock=0/1

Ask before breaking locks on network user profiles (recommended) 
checkbox: Produces a prompt that states the user profile is locked and asks you 
to override the lock preventing users from opening a Roaming user profile that is 
already in use. 

Network problems can cause a lock to become “stuck” and not release. 

Default 0 (checked) produces a prompt.

A setting of 1 breaks the lock automatically without producing a prompt.

ASW Override=0/1

(ASW is short for Audio Setup 
Wizard)

Set audio levels on each machine checkbox: Runs a Volume and Quality 
Check on the microphone each time you open a Roaming user profile. This 
setting affects all end-users. 

Turn this option on if your end-users experience reduced accuracy because of 
differences in the microphone, sound card, and ambient sound levels at different 
locations. 

Default 0 (checked) = On 

Roaming ASW 
Override=0/1

Set audio levels on each machine checkbox: Runs a Volume and Quality 
Check on the microphone each time you open a Roaming user profile. Set to 1 if 
the Roaming feature is enabled and ASW Override is 1. 

ASW Override and Roaming ASW Override should always have the same 
setting.

Roaming User Save 
Acoustics
=0/1

Save acoustic information checkbox: Sets whether acoustic adaptations 
made during a dictation session are saved.

Default 1 (checked) = On: Master user profile acoustic optimization applies the 
acoustic adaptation data from dictation sessions to the acoustic model for the 
profile. 

When set to 0, the .usr and .sig files created during dictation are not saved. 
Master user profile acoustic optimization does not apply the acoustic adaptation 
data from dictation sessions to the acoustic model for the profile.
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Option Description and UI equivalent

Roaming User Copy 
Dragon Log=0/1

Copy Dragon log to network checkbox: Copies the dragon.log file from 
the Local Roaming user profile location to the Master Roaming user profile 
location at the same time that the program synchronizes the local and the 
Master Roaming user profiles. 

Default 0 = Off

Roaming User Do Not 
Copy Dra Files=0/1

Conserve archive size on network checkbox: Controls files available to the 
Acoustic Optimizer during synchronization. 

Default 0 (unchecked) = Off; Acoustic data files from the latest dictation 
session are available to the Acoustic Optimizer when the program synchronizes 
the local and Master Roaming user profiles.

Turn this option on to prevent the transfer of acoustic optimization data to Local 
user profiles.

Roaming User Max 
Container Size=1000 MB

Disk space reserved for network archive field: Controls the maximum size 
for each container directory in the Master Roaming user profile directory. 

Default = 1000 MB

Roaming user options set in roamingdef.ini
The options below are saved in the encrypted roamingdef.ini file and should not be edited directly. You can 
control these settings in the Roaming User Network Location dialog, accessed by clicking the Add or Edit buttons 
in the Network Directories section of the Roaming tab.

Options Description and UI

[<Network Settings>] Display Name text field: name assigned to the network directory where 
Roaming user profiles are stored 

location Address text field: Path to a network directory, web server, or secure web 
server where Roaming user profiles are stored

HTTP Settings

type Authentication Type radio buttons: Basic or Digest

authscheme=1 Indicates authentication is required

queryforuserpassword Prompt for User and Password checkbox

authuser User text field: <domain>\<username> required to log in

authpassword Password text field: Actual password required to log in

followredirects Follow Redirects radio button: Never, Always, or Same Scheme Only

keepalive Keep Connection Alive checkbox

locktimeout Lock field in the Timeouts area: Number of seconds after timeout expires 
to lock the connection

connectiontimeout Connection field in the Timeouts area: Number of seconds after timeout 
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Options Description and UI

expires to close the connection

connectiontimeoutinactivity Type radio buttons in he Timeouts area: Set if you selected the Inactivity 
option.

connectiontimeoutabsolute Type radio buttons in the Timeouts area: Set if you selected the Absolute 
option

firewall Firewall and Proxy Servers: Set if a firewall is configured

proxy Use Proxy Server checkbox: Set if checked

proxyserver Network Location: URL to the web server

firewalltype Type dropdown: Type of firewall, represented by a number (enabled if Use 
Proxy Server is checked)

firewallhost Server text field: Name of server for the firewall (enabled if Use Proxy 
Server is checked)

firewallport=1080 Port: Port used by the proxy server or firewall – 1080 is the default (enabled 
if Use Proxy Server is checked)

firewalluser User text field: Login name of the administrator that can access the firewall 
(enabled if Use Proxy Server is checked)

firewallpassword Password text field: Password to log in to the firewall (enabled if Use 
Proxy Server is checked)

firewalldata Firewall Data or Proxy Authorization text field: Special authentication 
string for firewall or proxy server, if applicable (enabled if Use Proxy 
Server is checked)

SSL Settings 

sslcertstore Certificate Store radio buttons

sslcertstorepassword Certificate Store Password text field

sslcertstoretype Certificate Store Type radio buttons (represented by a number)

useopenssl Using OpenSSL checkbox

opensslcipherlist Cipher List text field (enabled if Using OpenSSL is checked)

opensslcafile Certificate Authority File path (enabled if Using OpenSSL is checked)

opensslcadir CA Directory path (enabled if Using OpenSSL is checked)

tls1 SSL Enabled Protocols checkbox: Version 1 of the Transport Layer 
Security (TLS) protocol

112



Dragon Installation Guide

Options Description and UI

ssl3 SSL Enabled Protocols checkbox: Version 3 of the Secure Sockets 
Layer (SSL) protocol

ssl2 SSL Enabled Protocols checkbox: Version 2 of the Secure Sockets 
Layer (SSL) protocol

pct1 SSL Enabled Protocols checkbox: Version 1 of the Private 
Communications Transport (PCT) protocol
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Installing a Roaming User Profile Configuration on Additional Computer(s)
The default Roaming user settings you created in “Setting Roaming User Profile Options” on page 107 will be 
transferred to your client computers only if you include the ROAMINGUSERINI option, set to roamingdef.ini. Use 
the full path to the file:

ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\"

If you do not pass the ROAMINGUSERINI option, default settings are used. You must also include the DEFAULTSINI 
option, set to nsdefaults.ini, as shown below.

For installations using setup.exe, your command line may look like this:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\Program Files\Nuance\NaturallySpeaking14\"
ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\"
/L*v C:\Logs\logfile.log /qn"

Note: Enclose long path names containing spaces in quotation marks (be sure to escape the each 
quotation mark with a backslash: \" ).

If you are using msiexec.exe to install, your command line might look like this:

msiexec.exe /i "Dragon 14.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\Program Files\Nuance\NaturallySpeaking14"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
/L*v "C:\nuanceLogs\logfile.log" /qn

After you have completed the installation, verify that all options are correctly set on the client computer.
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